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UC Connector 8.0.3 Deployment Guide
Welcome to the UC Connector 8.0.3 Deployment Guide. This document describes the deployment of
the Unified Communications (UC) Connector into the Genesys contact center, as well as the
integration of the UC Connector deployment with Microsoft Lync and Skype for Business, used as a
Unified Communications platform in the Enterprise.

This document concentrates in particular on the features and configurations of UC Connector that
implement the Genesys Smart Link use cases in the Enterprise. UC Connector can be used for this
either standalone, or in integration with Microsoft Lync / Skype for Business. For an in depth
description of the concepts and procedures needed for the UC Connector to integrate with Microsoft
Lync or Skype for Business, please see the UC Connector 8.0.3 Lync Integration Deployment Guide.

Note: This document is valid for the 8.0.301 release(s) of UC Connector.

About UC Connector
Find out about UC Connector:

Overview
How it Works
Supported Integrations

Deployment
Find out about the actions you must take
to deploy UC Connector:

Overview
Baseline Components
Deploying UC Connector
Deployment Procedures
High Availability

Other Topics
Find out about other important
information for:

Configuring Routing Strategies
Configuration Options
Log Events for UC Connector HA
T-Server Compatibility with UC Connector
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About UC Connector
The UC Connector enables enterprise-wide customer service. It connects the Genesys contact center
to the larger enterprise, allowing agents to consult the enterprise Knowledge Workers (off-site
experts or product specialists) and take advantage of their special or expert skills. You can also use it
independently from a Genesys contact center to enable Knowledge Workers to flexibly provide
customer service in a more personal setting or when a contact center is not part of the company
function.

In addition, the UC Connector is used as a component in other Genesys solutions to propagate
presence information about agents or other users to and from the corporate presence function, either
automatically when managed by Microsoft Lync 2010, Lync 2013, or Skype for Business, or manually
through its user interface.

This section includes the following topics:

• About the UC Connector
• New In This Release
• Functional Overview and Architecture
• High Availability
• Deployment Modes
• Limitations

About the UC Connector

As a Genesys server application, you deploy UC Connector in the Genesys environment.

The UC Connector is used as an integral part of the Genesys integration with Microsoft Lync or Skype
for Business, either in the contact center or the Enterprise. In this setting, UC Connector acts as a
presence gateway with the Microsoft server, propagating presence information from Microsoft to
Genesys and vice versa, and acting in concert with the Genesys SIP Server to provide call control
services to users.

With UC Connector, Genesys routing capability and business rules, which normally govern the flow of
communication within the contact center, are extended to control the flow of interactions into the
back office or branch office, as well as to provide end-to-end reporting on these interactions. The UC
Connector adds unique capabilities that make it easier to involve Knowledge Workers in customer
interactions without impacting their normal workflow, providing enterprise-wide customer service.

In addition, the UC Connector is used as an integral part of the Genesys integration with Microsoft
Lync Enterprise Voice, which is a contact center offering. In this setting, UC Connector acts as a
presence gateway with Microsoft Lync server, propagating presence information from Lync to
Genesys and vice versa, and acting in concert with the Genesys SIP Server to provide call control
services to users.

About UC Connector
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New in This Release

8.0.301

The following new features were introduced in release 8.0.301.00 of UC Connector.

• UC Connector can be configured to map Genesys agent states to Microsoft presence states, and then
push the Microsoft presence to Lync / Skype for Business. For more information, see Presence
Connector Mode.

• UC Connector now supports Free Seating where Knowledge Workers are not tied to a particular Place in
the configuration. For more information see Free Seating.

8.0.300

The following new features were introduced in release 8.0.300.00 of UC Connector.

• Customized Knowledge Worker states. UC Connector now allows you to customize the states
available to Knowledge Workers in the UC Connector web client drop-down menu. The Knowledge
Worker states and the corresponding text displayed in the menu can be customized by editing
application resources. See Customized Knowledge Worker States.

• External number redirect. A user or an Administrator can now enable an external redirect number.
Enabling this feature allows agents to accept preview calls at the specified number. See External
Number Redirect.

• Propagation of Genesys After Call Work state to Lync, in integration with Microsoft Lync
Enterprise Voice. When an agent enters the After Call Work state, the agent's presence state is:
• Preserved in Genesys until the agent uses the Lync client menu to change state, or the After Call

Work timer expires.
• Propagated to the Lync server so that the agent's unavailability is also reflected in the

corresponding Lync presence, with a configurable presence status and note values.

When the agent exits the After Call Work state (either automatically or
manually), the agent's Lync presence state is set back to a value that is
preserved from the Lync presence update. The agent's Genesys state is also
updated with the corresponding value. See Enabling After Call Work.

8.0.200

The following new features were introduced in release 8.0.200.00 of UC Connector.

About UC Connector New in This Release
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• Interaction Preview-related reporting events. UC Connector now creates reporting-related records
in ICON for the user actions in the Preview window. Reporting tools can extract these records to create
reports on the performance of Knowledge Workers while responding to previews. See Reporting Events.

• Configurable hotkeys for interaction Preview. You can now configure keyboard hotkeys to perform
key actions when the Preview window is in focus. See Configuring Hotkeys for Interaction Preview.

• Play audio with interaction Preview. You can now add a custom audio file that UC Connector plays
when the Preview window is displayed. See Enabling Audio on Preview or Ringing.

• User logout ability. Users can now explicitly logout of UC Connector by clicking a button in the user
interface. See enable-logout-menu on Configuration Options.

• Default routing. UC Connector now includes an login-queue on Configuration Options.
• Third-party call control window suppression. UC Connector now suppresses web browser pop-ups

for incoming calls based on User Data attached to the call. See popup-udata-key on Configuration
Options.

• Username in browser window. UC Connector now displays the username for the logged in user in
the browser window. The displayed string shows "first name" + <space> + "last name" + "- Genesys",
as specified in the Person object for the logged in user in Configuration Manager.
• John Smith - Genesys

If neither field is present, then the Person user ID will be used:
• LyncKW9 - Genesys

8.0.100

The following new features were introduced in release 8.0.100.00 of UC Connector.

• Customized Help Button. UC Connector now includes a Help button, which you can use to link to a
customized help files located on your network or server. You can How It Works Customized Help.

• Customized Default Languages. UC Connector now lets you select from a variety of supported
languages to be used in the interface. See Customized Languages.

• Automated UC Connector Log-in. UC Connector now supports automatic log-in for all users on
startup. This feature must be enabled for integrations with Microsoft Lync Server 2010. See user-auto-
registration on Configuration Options.

• Enhanced Support for Microsoft Lync Server 2010. UC Connector now uses the Microsoft Lync
extensibility window ("conversation extension window" in later versions) for integration with UC
Connector. See Lync / Skype for Business Integration.

• Countdown Timer. The interaction Preview window disappears automatically after a timeout if the
user does not accept or reject the interaction. This The Overall Preview Interaction.

8.0.001

The following new features were introduced in release 8.0.001.00 of UC Connector.

• Enhanced Instant Messaging Integration. UC Connector now supports integrations with Genesys
Instant Messaging (IM), independently of the third-party UC platform used. This allows for IM

About UC Connector New in This Release
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functionality in IBM Sametime 8.x deployments. For Microsoft OCS, you can now choose instant
messaging through Genesys IM or through the previous OCS-SIP Server integration.

• Support for Microsoft Lync Server 2010. UC Connector now supports integration with Microsoft Lync
Server, for both voice and chat interactions.

8.0.0

The following features were included in the initial release 8.0.0 of UC Connector:

• Support for UC platforms. UC Connector supports integration with Microsoft OCS 2007 R2 and IBM
Sametime 8.5.

• Presence Mapping. UC Connector determines Knowledge Worker availability by subscribing to user
presence (states/updates) provided by the UC platform.

• Telephony Integration. Knowledge Worker telephony integration is available through T-Server, for
calls flowing from the contact center to the Enterprise. Voice call control is provided through the
standard UC client.

• Instant Messaging Integration. When integrated with the Microsoft Office Communication Server,
UC Connector supports interaction flows that use the IM integration through SIP Server. IM content and
call control is provided through the Microsoft Office Communicator UC client.

• Interaction Preview Notification. Genesys Routing can send a preview to a targeted Knowledge
Worker, letting the Knowledge Worker accept or decline the interaction before actually routing the
interaction. This can be done for a selected Knowledge Worker, or round robin for a group of Knowledge
Workers. Multiple preview notifications can also be sent simultaneously"roadcast"o a set of Knowledge
Workers. In this case the first Knowledge Worker to respond receives the interaction.

• Business Data Exchange. The Knowledge Worker can access call context and attached data related
to any interaction that is transferred to them. Genesys UserData is passed to the UC client, displayed
on their Interaction window, the Preview window, or the custom UC Connector tab of their UC client,
depending on the configuration.

• Limited Enterprise Footprint. All deployment related to the integration with the UC platform takes
place on the Genesys side, with no need for any new applications to be running on the Knowledge
Worker desktop.

• Reporting. Business and performance metrics about the Knowledge Worker voice activity is provided
through the Genesys Reporting solution. Knowledge Workers are configured in the Genesys system as
standard agents, and standard reporting products and templates can be used to generate reports on
how the Knowledge Worker is used or how the call is handled.

About UC Connector New in This Release
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UC Connector Overview and Architecture
This section provides an overview of UCC Connector and describes its general architecture.

The Main Features

The following table lists the most notable features of UC Connector.

Feature Description Reference

Presence Monitoring

UC Connector determines
Knowledge Worker availability by
subscribing to user presence
(states/updates) provided by the
UC platform.

Presence

Free seating

Knowledge Workers are not tied
to a particular place in the
configuration. Instead, the agent
and DN are dynamically assigned
based on the attribute AgentID
of the corresponding TLib event.

Free Seating

Telephony Integration

Knowledge Worker telephony
integration is available through T-
Server, for calls flowing from the
contact center to the Enterprise.
Voice call control is provided
through the standard UC client.

Telephony Integration

Instant Messaging Support

When integrated with Lync /
Skype for Business, UC
Connector supports interaction
flows that use the IM integration
through SIP Server. IM content
and call control is provided
through the Lync /Skype for
Business client. When deployed
standalone, UC Connector can
serve instant message
interactions through its thin
client user interface.

IM Integration

Interaction Preview
Notification

Genesys Routing can send a
preview to a targeted Knowledge
Worker, letting the Knowledge
Worker accept or decline the
interaction before actually
routing the interaction. This can
be done for a selected
Knowledge Worker, or round
robin for a group of Knowledge
Workers. Multiple preview

Preview

About UC Connector UC Connector Overview and Architecture
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Feature Description Reference
notifications can also be sent
simultaneously—broadcast—to a
set of Knowledge Workers. In this
case the first Knowledge Worker
to respond receives the
interaction.

Business Data Exchange

The Knowledge Worker can
access call context and attached
data related to any interaction
that is transferred to them.
Genesys UserData is passed to
the UC client, displayed on their
Interaction window, the Preview
window, or the custom UC
Connector tab of their UC client,
depending on the configuration.

Transfers

Limited Enterprise Footprint

All deployment related to the
integration with the UC platform
takes place on the Genesys side,
with no need for any new
applications to be running on the
Knowledge Worker desktop.

Reporting

Business and performance
metrics about the Knowledge
Worker voice activity is provided
through the Genesys Reporting
solution. Knowledge Workers are
configured in the Genesys
system as standard agents, and
standard reporting products and
templates can be used to
generate reports on how the
Knowledge Worker is used or how
the call is handled. In addition
special reporting is available to
track interaction previews. This is
treated as a separate feature,
see below for details.

Reporting

Interaction Preview-related
Reporting Events

UC Connector can create
reporting-related records in ICON
for the user actions in the
Preview window. Reporting tools
can extract these records to
create reports on the
performance of Knowledge
Workers while responding to
previews.

Reporting

Default Routing

UC Connector includes an
application-wide option to allow
default routing in case of
Universal Routing Server failure,
if this functionality is supported
by the T-Server and other

login-queue

About UC Connector UC Connector Overview and Architecture
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Feature Description Reference
solution components.

Countdown Timer

The interaction Preview window
disappears automatically after a
timeout if the user does not
accept or reject the interaction.
This widget allows the user to
see the time remaining to
respond to the preview.

Timer

Customized Help Button

UC Connector includes a Help
button, which you can use to link
to customized help files located
on your network or server. You
can hide or show this help button
as it appears in various parts of
the user interface.

Help Button

Automated UC Connector
Login

UC Connector supports
automatic login for all users on
startup. This feature must be
enabled for integrations with
Microsoft Lync / Skype for
Business.

Optional Customization

Customized Default
Languages

UC Connector lets you select
from a variety of supported
languages to be used in the
interface.

Default Language

Customized Knowledge
Worker States

UC Connector allows you to
customize the states available to
Knowledge Workers in the UC
Connector web client drop-down
menu. The Knowledge Worker
states and the corresponding
text displayed in the menu can
be customized by editing
application resources.

Knowledge Worker

External Number Redirect

A user or an Administrator can
enable an external redirect
number. Enabling this feature
allows agents to accept preview
calls at the specified number.

Redirect Number

Enterprise Voice

When an agent enters the After
Call Work state, the agent's
presence state is:

• Preserved in Genesys until the
agent uses the Lync client
menu to change state or the
After Call Work timer expires.

• Propagated to the Lync server
so that the agent's
unavailability is also reflected
in the corresponding Lync

After Call Work

About UC Connector UC Connector Overview and Architecture
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Feature Description Reference

presence with a configurable
presence status and note
values.

When the agent exits the After Call Work
state (either automatically or manually)
the agent's Lync presence state is set
back to a value that is preserved from the
Lync presence update. The agent's
Genesys state is also updated with the
corresponding value.

Play Audio with Interaction
Preview

You can add a custom audio file
that UC Connector plays when
the Preview window is displayed,
for additional alerting of
knowledge workers.

Audio

Configurable Hotkeys for
Interaction Preview

You can configure keyboard
hotkeys to perform key actions
when the Preview window is in
focus.

Hotkeys

The Main Components

The main components and actors involved in the UC Connector interaction between contact center
and enterprise are as follows:

About UC Connector UC Connector Overview and Architecture
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• Customer—Customers use voice channels to connect with customer service provided by the Genesys
contact center or directly to the enterprise through Genesys UC Connector.

• Contact Center Agent—Contact center agents have CTI-enabled phones and an Agent Desktop client
(Genesys Workspace Desktop Edition, for example) that supports UserData. They can involve enterprise
Knowledge Workers in the customer interactions through the UC Connector using voice or IM.

• Enterprise Knowledge Worker—Enterprise workers are not generally considered part of the contact
center but their expertise can benefit customer interactions. The UC Connector can involve them
directly in customer service even if a contact center is not deployed.
Knowledge Workers are represented inside Genesys as agents (person objects in the Configuration
Database) with access to all business rules, routing, and reporting available to regular agents.

• Microsoft UC solution—The Unified Communications (UC) software system used by the enterprise. In
8.0, UC Connector supports integration with the following UC solutions:
• Microsoft Lync 2010/2013
• Microsoft Skype for Business 2015

• UC Connector—The Genesys component used to integrate the Genesys environment with the third-
party UC solution and enable enterprise-wide customer service.

The Main Functions

The main functions provided by a UC Connector integration are:

• Voice interaction—The customer uses voice to connect with the contact center or directly with the
enterprise customer service function. The agent can also use voice when contacting the Knowledge
Worker to determine availability (for example, when initiating a voice transfer).

• Instant Messaging (IM)—The agent can contact a Knowledge Worker using IM, either to ask if the
Knowledge Worker can accept a particular customer interaction, or to pass typed information for
convenience during a phone conversation.

• Presence Monitoring—By integrating with the third-party UC solution the Genesys environment is
able to determine the availability status of a given Knowledge Worker so that it knows who might be
available to handle the customer interaction. Note that in case of standalone deployment (not
integrated with the Microsoft UC platform) UC Connector manages the presence of Knowledge Workers
directly from their browser window.

• Interaction Preview Notifications—Knowledge Workers may not have job roles that allow for
interruptions, even when their presence status shows they are available. When an agent sends a
customer interaction to the Knowledge Worker a screen pop arrives at the Knowledge Worker's desktop
providing relevant information about the current customer interaction. This gives the Knowledge
Worker the opportunity to accept or decline the interaction based on their real availability.

Basic Architecture

The following diagram shows the different server elements involved in a UC Connector deployment,
as well as the kinds of interfaces used to communicate among the components.

About UC Connector UC Connector Overview and Architecture
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Genesys Components in the Solution

The server components included in the basic architecture include the following:

• SIP Server—SIP Server—Provides both a SIP and T-Library interface. SIP Server can act as a T-Server
and softswitch for deployments with no third-party PBX. SIP Server is required for Instant Messaging.

Warning
T-Server must support emulated agent functionality to integrate with UC Connector.
Most T-Servers include this functionality; for a list of supported T-Server please see the
T-Server Compatibility topic.

• Universal Routing Server (URS)—Universal Routing Server (URS)—Provides Genesys routing for the
customer interaction. Universal Routing Server processes the routing strategies designed in Interaction
Routing Designer (IRD) that govern how the interaction is processed. The UC Connector integrates with
URS as a Custom Server, using a proprietary protocol to execute, in this case, the Preview Mechanism
for the Knowledge Worker selected in the routing strategy.

• Workspace Desktop Edition—The interface that appears on the desktop of Genesys contact center
agents. Agents can use their Workspace Desktop Edition to send the customer interaction to the expert
user or Knowledge Worker in the Enterprise, including any important notes or information that would be
helpful to the expert.

About UC Connector UC Connector Overview and Architecture

UC Connector Deployment Guide 15



Warning
Workspace Desktop Edition is not mandatory to the deployment. If using a different
desktop client for your agents, some custom functionality might be required.

• Stat Server—Tracks information about the customer interaction. For UC Connector, Stat Server is used
to monitor the DNs, agents, emulated agents, and other objects, making their states available to other
Genesys components, in particular to URS for Genesys routing. UC Connector is also able to use
statistics—for example, number of calls in a queue—that it can display in the Interaction window so
that Knowledge Workers can check availability of a Contact Point before transferring a call.

• Local Control Agent (LCA)—The LCA is deployed on each host computer running Genesys
components and is used to monitor the operating status of all locally running Genesys software.

• Configuration Server—Stores and manages the Configuration Database data that users can access
through Configuration Manager or Genesys Administrator.

• Message Server—Receives error messages from all installed Genesys application and logs them into a
common database.

Communication Between Components
The following table shows the protocols and libraries used for communication between the various
server components.

Function or Connection Interface Description
Communication Between Genesys Components

Call control T-Library messaging All call control uses the Genesys
proprietary T-Library protocol.

Instant Messaging in standalone
mode T-Library, HTTP

When not integrated with
Microsoft Lync or Skype for
Business, instant messages
travel via T-Library between
server components, and to a
browser window over HTTP to the
recipient’s screen..

Microsoft Lync or Skype for Business

Presence exchange between UC
Connector and Lync / Skype for
Business Front End Server

MS-PRES protocol (extended SIP
from Microsoft)

MS-PRES extends SIP/SIMPLE in
several ways for presence
propagation. Please see
https://msdn.microsoft.com/en-
us/library/office/
cc431501(v=office.12).aspx for a
full definition of the MS-PRES
protocol.

Instant Messaging SIP messaging SIP is used in direct Lync-SIP
Server integration.

Lync or Skype for Business client HTTP A web-based "conversation

About UC Connector UC Connector Overview and Architecture

UC Connector Deployment Guide 16



Function or Connection Interface Description

integration
extension window" in the Lync or
Skype for Business client uses
HTTP between UC Connector and
the client.

High Availability

As a Genesys server component, UC Connector supports the warm standby redundancy and the IP
takeover methods for a highly available (HA) deployment, meaning that a backup UC Connector
server application remains initialized and ready to take over the operations of the primary server
when needed. For more information, see UCC Connector High Availability Deployment.

Components

About UC Connector UC Connector Overview and Architecture
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As a solution, different HA methods are used to provide greater reliability for the connections among
the various components. HA is supported for the following connections:

• HA connections to Genesys servers established by UC Connector.
• HA connections to UC Connector established by Genesys servers.
• HA connections between UC Connector and the third-party UC platform.
• HA connections to UC Connector established by the UC client.

Genesys Servers

High Availability with Genesys Servers
The warm standby method is used for connections with Genesys Stat Server, Configuration Server,
and Message Server. In this case, if any of these connections fails, the UC Connector will try to re-
connect with the backup server instance. After a successful reconnection, UC Connector continues
normal operation.

Genesys T-Servers

High Availability with Genesys T-Servers
For connections with T-Server, the hot standby method for HA provides a more robust redundancy. In
this case, the solution maintains a connection with both T-Server instances, actively passing call data
from primary to backup T-Server. This lessens the interruption in service, and allows for better
survival of calls after the switchover process.

Warm standby connections are also supported with T-Server.

For more information, consult the Deployment Guide for your T-Server.

Universal Routing Server

High Availability with Universal Routing Server
For connections established from Universal Routing Server (URS) and the UC Connector, the warm
standby method is used. If URS connection to UC Connector fails, it reconnects with the backup UC
Connector instance, then resumes normal operation. Call processing during this process is dropped or
delayed.

Connections to UC Connector initiated through the Custom Server are switched over as part of the
Windows NLB configuration, together with the web interface. For configuration details, see High
Availability.

About UC Connector UC Connector Overview and Architecture

UC Connector Deployment Guide 18



Third-Party UC Plaform

High Availability with Third-party UC platform
For connections with the third-party UC platform, the HA method used depends on which UC platform
the UC Connector is integrated with.

HA is only supported with Enterprise Edition of Microsoft Lync / Skype for Business (Standard Edition
places all components on a single host).

Multiple Front End Servers make up a highly available pool of resources. UC Connector initiates and
manages the connection to the FE Servers pool, which is contacted through a single URL or virtual IP
address. If the connection between UC Connector and this contact point fails, UC Connector initiates
the re-connection process. In this case, the Microsoft platform is configured behind a third-party load
balancer. For a sample architecture diagram, see the Microsoft Lync or Skype for Business diagram
above. For additional information, see the consult the Microsoft documentation.

Configuring High-Availability UC Connector Instances
For information about configuring UC Connector for a high-availability deployment, see UC Connector
High Availability Deployment.

Deployment Modes

You can deploy and configure UC Connector in four different modes listed in this section.

About UC Connector UC Connector Overview and Architecture
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Normal Mode

This is the typical UC Connector deployment, in which UC Connector subscribes to a Unified
Communications system for presence synchronization, and acts as a web server to present
interaction preview pop-ups and call control windows to users.

About UC Connector UC Connector Overview and Architecture
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Standalone Mode

In standalone mode, UC Connector does not subscribe to a Unified Communications system to
receive the user's presence. This may be because no compatible UC system is present in the
Enterprise. In this case, UC Connector uses its own information to relay presence information to the
Genesys environment. Users can control their presence state manually, by logging in and out of the
UC Connector and acting on the control to put themselves in one of the presence states that are
defined for them. See Customizing Knowledge Worker States in Customizing UCC Connector and the
enable-logout-menu option.

Tip
These options are only enabled in standalone mode.

About UC Connector UC Connector Overview and Architecture
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Presence propagation with a SIP Server-based integration with Lync or Skype for
Business

Genesys can integrate with Lync or Skype for Business Enterprise Voice deployments using the SIP
Server as a SIP Application Server. This integration only supports voice from the PSTN, and exchanges
presence between Microsoft and Genesys using the UC Connector. Here the UC Connector subscribes
to presence from the Lync or Skype for Business Front End Server and maps it into Genesys presence
for agents. It can also push Genesys presence to Microsoft, for states that are not covered by Lync or
Skype for Business like After Call Work or Legal Guard. Please see the UC Connector Lync Integration
Deployment Guide for detailed information about this mode.

Tip
Genesys also offers a native integration with Lync 2013 and Skype for Business that
does not use UC Connector. Please see the Genesys Web site for information on the
Multimedia Connector for Skype for Business.

About UC Connector UC Connector Overview and Architecture
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Presence Connector for Lync or Skype for Business

In this case UC Connector is used to push presence of agents in a Genesys Contact Center to the
Microsoft-based corporate presence, so co-workers know when an agent is available or busy. Agents
in this mode receive voice service from Genesys, and not Lync or Skype for Business. However, the
corporate presence is based on Microsoft and it is necessary to let the agents’ coworkers know about
their status. UC Connector pushes the Genesys presence state to Microsoft, after mapping the
presence to a Microsoft state.

Example of Messaging

Below is an example of messaging when UC Connector, while in the “pull” mode, monitors the
Presence Information of the Lync contacts. When a call arrives at the Lync agent, UC Connector
receives a SIP notification “On a Call” from the Lync server and sends the RequestAgentNotReady
request to T-Server for the corresponding agent DNs.

16:59:31.140 Dbg 09900 [DEBUG] <<< receiving request
[NOTIFY sip:192.168.92.172:55117;ms-received-cid=3C0D700;grid SIP/2.0
Via: SIP/2.0/TLS
192.168.92.74:5061;branch=z9hG4bKEDA8FDD1.3DDFA90BEAFEDDF3;branched=FALSE;rport=5061,SIP/2.0/
TLS 192.168.92.75:56267;branch=z9hG4bK7CCE6513.0400ED9AB1C66DF3;branched=FALSE;ms-received-
port=56267;ms-received-cid=3747900
Max-Forwards: 69
To: <sip:lync-user0@lyncdco13.lab>;epid=56b4641a00000000;tag=f30acb63
From: <sip:lync-user0@lyncdco13.lab>;tag=D62C0080
Call-ID: 07dd7d53ddd1f347e9cebe4d99abed50@192.168.92.172

About UC Connector UC Connector Overview and Architecture
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CSeq: 4 NOTIFY
Require: eventlist
Content-Type: application/msrtc-event-categories+xml
Event: presence
Subscription-State: active;expires=29909
Supported: ms-dialog-route-set-update
Content-Length: 659

<categories xmlns="http://schemas.microsoft.com/2006/09/sip/categories" uri="sip:lync-
user2_qa94@lyncdco13.lab"><category xmlns="http://schemas.microsoft.com/2006/09/sip/
categories" name="state" instance="1" publishTime="2017-08-22T23:59:31.107">
<state xsi:type="aggregateState" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="http://schemas.microsoft.com/2006/09/sip/
state"><availability>6500</availability><activity token="on-the-phone" /><delimiter
xmlns="http://schemas.microsoft.com/2006/09/sip/commontypes" /><device>computer</device><end
xmlns="http://schemas.microsoft.com/2006/09/sip/commontypes" /></state>
</category>
</categories>]

16:59:31.148 Dbg 09900 Sending message to 'Voice.TServer@SIPS - tcp://192.168.92.172:33243'
message: 'RequestAgentNotReady' (11) attributes:

AttributeReferenceID [int] = 13
AttributeThisDN [str] = "5002"
AttributeReasons [bstr] = KVList:

'KW_UC_STATUS' [str] = "busy"
'KW_UC_NOTE' [str] = ""
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Limitations
UC Connector 8.0 currently has the following limitation:

• UC Connector does not support After Call Work (ACW) time for Knowledge Worker users. Ensure that
ACW in the Agent Login for the Knowledge Worker is disabled (set both wrap-up-time and legal-
guard-time to 0).

Tip
ACW is supported for contact center agents who use Microsoft Lync Voice.
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How It Works
This section describes how the different functions enabled by the UC Connector work. It contains the
following topics:

• UC Connector GUI
• Voice Scenarios
• Instant Message Scenarios
• Presence Monitoring
• Free Seating
• The Preview Window
• The Interaction Window
• Reporting Events
• Lync Integration
• Customized Help
• Customized Languages
• Customized Knowledge Worker States
• External Number Redirect
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UC Connector GUI
UC Connector shows a thin-client GUI to users, which allows limited agent operations. The GUI allows
users to log into and out of Genesys, to change their Genesys status, to set up alternative phone
numbers to be reached (if enabled), and to access current interactions.

Logging into Genesys is done directly from the UC Connector GUI only in standalone mode. If UC
Connector is also integrated with Microsoft Lync or Skype for Business, logging into the Microsoft
platform automatically logs the user into Genesys as well. So this window is shown only for
standalone deployments:

Users simply enter their Genesys username and password, and click on Login. The Help link points to
a special URL that can be customized from the UC Connector options and so it can be changed as
appropriate for each deployment.
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Once the user is logged in, the GUI has two tabs. The first tab shows information about the current
interaction (when an interaction is ongoing). The states that can be set from the presence control
button are customizable (see Customized Knowledge Worker States). Also, when in standalone mode
the button allows to log out of UC Connector.

The second tab shows the channels (DNs) that are enabled for the Knowledge Worker, and allows the
user to enable / disable them individually. For instance, a user may be ready to receive IM
interactions and not voice calls, or may wish calls to be sent to a mobile phone instead of the desk
phone.
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Voice Scenarios
The UC Connector integration supports voice interactions between the Knowledge Worker, the
contact center agent, and the customer. This can involve direct calls from the customer to the
enterprise customer service function, or transfers and conference calls initiated by the agent.
Knowledge Worker transfers to agents in the contact center are also available, as well as transfers
and conferences between Knowledge Workers.

Contact Center to Knowledge Worker

In this scenario, either a customer calls directly into a number that maps to a group of Knowledge
Workers engaged in customer support (bypassing the contact center) or a contact center agent
engaged in a voice call with a customer decides that help from an expert outside of the contact
center is needed, and so initiates a call transfer. In both cases the interaction can go either to a
particular Knowledge Worker, or more commonly to a group of Knowledge Workers.

The call flow for this scenario is as follows:

1. The customer dials the contact center and a voice channel is established with a particular agent.
Regular Genesys call distribution from a Routing Point or ACD Queue determines which agent will
handle the customer interaction.

2. The agent decides that a Knowledge Worker is needed to satisfy the customer interaction. From their
Interaction Workspace, the agent initiates a call transfer to a designated Knowledge Worker Routing
Point DN.

3. Or, the customer contacts an Enterprise Customer Support number directly, which does not involve the
contact center.

4. The routing strategy loaded onto this Routing Point DN determines how the particular Knowledge
Worker is selected. You can design the strategy so that:
• The agent specifies the specific Knowledge Worker that they need.
• The routing strategy selects a particular Knowledge Worker from a group, using a round-robin

approach based on worker availability. This distributes the workload, making sure the same expert
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is not overused (recommended approach).
• The routing strategy sends or "broadcasts" multiple Preview Notifications simultaneously to a group

of Knowledge Workers. The interaction will be routed to the first Knowledge Worker who accepts.

5. Presence monitoring (through integration with Genesys Stat Server and Management Layer) determines
which Knowledge Workers are currently available, and this information is made available to the routing
strategy.

6. Using the presence information, the routing strategy selects an available Knowledge Worker.
7. Universal Routing Server (URS) sends a Preview Interaction to the selected Knowledge Worker screen

pop arrives at the Knowledge Worker's desktop or device, asking if they will accept the interaction.
• If the Preview is accepted, the customer call is then routed to the Knowledge Worker and a new

voice channel between the customer and enterprise expert is created.
• If the Preview is declined, URS can apply default routing or select another available Knowledge

Worker for Preview, depending on the strategy.

Knowledge Worker to Contact Center

In this case, the Knowledge Worker is already involved in a customer call—typically after a successful
transfer from contact center to Knowledge Worker earlier in the customer interaction. For whatever
reason—to collect more user information, for example, or process a new order—the Knowledge
Worker decides it is necessary to transfer the customer back to the contact center.

To do this the Knowledge Worker can use the UC Connector client window in her browser to send the
call to an agent in the contact center. Regular Genesys routing is used to select a particular
agent—for example, the Knowledge Worker sends the call to a Genesys Routing Point DN, where the
strategy selects a particular agent based on skill, group, and so on.

A common call flow for this scenario is as follows:

1. A Knowledge Worker is engaged in a voice call with a customer, with no other party or contact center
agent involved (in other words, this is not a conference or consultation call with the initiating agent still
involved).

2. The Knowledge Worker decides that the call should be sent to the contact center, either back to the
original agent who started the customer interaction, or for further processing by the contact center (for
example, to an IVR for a customer satisfaction survey).

3. To initiate the transfer, the Knowledge Worker uses the Interaction window to select a configured UC
Connector contact point. This contact point is mapped to a Routing Point DN in the Genesys
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environment.
4. Once the call arrives on the Routing Point DN, the routing strategy loaded on the DN is responsible

for selecting an available agent, configured for the business rules of the contact center.
5. Connection between customer and selected agent is established.

Knowledge Worker to Knowledge Worker

In this case, a Knowledge Worker already engaged on a customer voice call decides that the
interaction should be handled by another Knowledge Worker in the enterprise. The call is routed
through the Genesys environment, and the targeted Knowledge Worker is sent an Interaction Preview
asking if they can accept the customer call.

A common call flow for this scenario is as follows:

1. A Knowledge Worker is engaged in a voice call with a customer.
2. The Knowledge Worker initiates a transfer or conference to another Knowledge Worker in the enterprise

by selecting a contact point in the Interaction window. This contact point is mapped to a Routing
Point DN in the Genesys environment.

3. Once the call arrives on the Routing Point DN, the routing strategy loaded on the DN begins the
process of selecting an available Knowledge Worker.

4. Presence monitoring determines which Knowledge Workers are currently available, and this information
is made available to the routing strategy.

5. Using this presence information, the routing strategy selects an available Knowledge Worker.
6. Universal Routing Server (URS) sends a Preview Interaction to the selected Knowledge Worker—a screen

pop arrives at the Knowledge Worker's desktop or device, asking if they will accept the interaction.
• If the Preview is accepted, the customer call is then transferred to the new Knowledge Worker.
• If the Preview is declined, URS can apply default routing, or select another available Knowledge

Worker for Preview, depending on the strategy.

7. If the Preview is accepted, the customer call is then transferred to the new Knowledge Worker. If the
Preview is declined, URS can apply default routing, or select another available Knowledge Worker for
Preview, depending on the strategy.
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Free Seating
Starting with Release 8.0.301.04, UC Connector supports "free seating”, in which users (could be
Agents or Knowledge Workers) are not tied to a particular place in the configuration. Instead, the
agent and DN are dynamically assigned based on the attribute AgentID of the corresponding TLib
events:

• EventRegistered

• EventAgentLogin

• EventAgentLogout

Free seating is in addition to the currently supported static agent and DN assignment based on the
default Place.

With free seating, UC Connector supports a user logging into any Place with Person/password
details, and then using the DN associated with that Place. The dynamically-assigned DN will be
unassigned when the user logs out from the DN. If the DN is subsequently statically assigned to
another user by configuration, the dynamic assignment is canceled.

UC Connector can dynamically link a Knowledge Worker and Place if the following conditions are
met:

1. user-auto-registration = true

2. sync-when-logout = true

3. UC Connector is connected to Lync / Skype for Business.

Free Seating and Web Interface Login
The free seating feature supports Knowledge Workers logging into a UC Connector web UI. In this
case:

• UC Connector only uses the Knowledge Workers default Place.
• UC Connector will show all assigned agent DNs.
• Any dynamically-assigned DN disappears after logout.
• Preview and Call Control UIs are available for all assigned DNs.
• A statically-unassigned DN (if previously dynamically assigned to another Knowledge Worker ) is marked

by yellow triangle:
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Statically-Assigned DNs
UC Connector continues its support of static DN assignment to Knowledge Workers (agents) using the
default Place. UC Connector updates the DN list based on the following events:

Event UC Connector Processing

Configuration Processing
On startup, UC Connector reads all agents, Places
and DNs from the Configuration. An Initial list of the
agent DNs is created based on each agent’s default
Place.

Adding a DN to a Place

When a new DN is added to an agent’s default
Place, UC Connector processes the corresponding
event from Configuration Server and assigns the
new DN to the agent. In the case where another
agent is logged into the DN, the DN is marked as
“unassigned” for the agent.

Removing a DN from a Place

When an existing DN is removed from an agent’s
default Place, UC Connector processes the
corresponding event from Configuration Server and
removes the DN from the agent. In the case where
the agent is logged into the DN, the DN is marked
as “dynamic” and kept assigned to the agent until
logout.

Default Place Change

When an agent’s default Place is changed (or
assigned), UC Connector processes the
corresponding event from Configuration Server and
updates the agent’s DN list accordingly. See
“Adding DN to a Place” and “Removing DN from a
Place” above.

Adding a New Agent Login

When an Agent Login is added to an agent’s Login
list, UC Connector processes the corresponding
event from Configuration Server. If the
corresponding Login Code is already being used by
the agent, a re-login is required.

Removing an Agent Login

When an Agent Login is removed from an agent’s
Login list, UC Connector processes the
corresponding event from Configuration Server. If
the corresponding Login Code is already being used
by the agent, the corresponding DN is kept in the
“logged in” state.

Login to the Default Place

UC Connector sends RequestAgentLogin for the
DN under default Place in the following cases:

• Option sync-when-logout = true.
• Option presence-sync-mode = pull.
• Option user-auto-registration = true.
• The user is logged into the UC Connector Web

UI, and the option presence-sync-mode = pull.
The option agent-initial-state is controlling the
process also.
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Instant Message Scenarios
Contact center agents can use Instant Messaging to communicate with a Knowledge Worker in the
enterprise, either to approach a Knowledge Worker about a particular customer interaction, or to
convey information about an existing call through an IM session (text).

Agent Sends IM During a Customer Call

In this scenario, an agent is currently on a call with a customer when the agents starts an Instant
Message with a Knowledge Worker. Once the IM with the Knowledge Worker is established, the agent
can continue chatting with the Knowledge Worker—for example, to obtain some expert details to
pass on to the customer on the call or they can initiate a voice connection (escalate the customer
interaction) to the Knowledge Worker by transfer or conference.

A common call flow for this scenario is as follows:

1. An agent is engaged in a voice call with a customer.
2. The agent decides that a Knowledge Worker is needed to satisfy the customer interaction. From their

Interaction Workspace, the agent initiates an IM to a designated Knowledge Worker Routing Point DN.
3. The routing strategy loaded onto this Routing Point DN determines how the particular Knowledge

Worker is selected.
4. Presence monitoring (enabled by UC Connector ability to map UC presence status to Genesys agent

states) determines which Knowledge Workers are currently available, and this information is made
available to the routing strategy.

5. Using the presence information, the routing strategy selects an available Knowledge Worker.
6. Universal Routing Server (URS) sends an Interaction Preview to the selected Knowledge Workers—a

screen pop arrives at the Knowledge Worker desktop, asking if they will accept the interaction.
• If the Preview is accepted, the IM is then routed to the Knowledge Worker, and the IM session

between agent and Knowledge Worker begins.
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• If the Preview is declined, URS can apply default routing, or select another available Knowledge
Worker for Preview, depending on the strategy.

7. The agent can then continue chatting, or the agent can transfer or conference (escalate) the customer
call to the Knowledge Worker. In the case of transfers, this can be done through either of the following
methods:

8. The call is sent to a Routing Point DN with the relevant attached UserData to identify the Knowledge
Worker currently handling the IM. Depending on the business rules, the strategy can then present a
preview or just route the call directly.

9. With Interaction Workspace, the voice DN of the Knowledge Worker who accepted the IM is presented as
a transfer target to the initiating agent. The agent can then transfer the call directly to this Knowledge
Worker, without going through a Routing Point.

The IM and the voice call are handled separately.
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Presence Monitoring
To determine whether a particular Knowledge Worker is available for a customer interaction, the UC
Connector monitors the presence status of the Knowledge Worker on the UC platform. Knowledge
Workers are integrated into the Genesys environment as emulated agents, and their presence status
in the UC client is mapped to a corresponding "agent status" in the Genesys contact center. Any
change in the status in the UC client for a particular Knowledge Worker triggers a corresponding
change in agent status, as monitored by Stat Server.

Changing Knowledge Worker Status in Genesys

When the UC Connector receives notification about a change in presence status for a particular
Knowledge Worker, it sends a T-Library request to change the status of the corresponding Knowledge
Worker "agent" (RequestAgentLogin, RequestAgentReady, and so on) to the T-Server that manages
the Knowledge Worker's Genesys DN. The exact mapping of UC client presence status to Genesys
agent status is configurable, but the default mapping is shown in the following table.

UC Presence Status UC Presence Status
Online Ready
Offline LoggedOut
Any other status NotReady + Reason code

T-Server Support for Emulated Agents

Because the Knowledge Worker must be configured as an emulated agent, the T-Server managing the
Knowledge Worker DN must support the emulated agent feature. See T-Server Compatibility.

Presence and Agent-Status Scenarios

Changes in the Knowledge Workers presence in Genesys can come from the Microsoft side, or from
the UC Connector (Genesys) side, depending on the scenario. UC Connector integrates both sources
of presence for each user. The following table describes some of the scenarios that result in a change
of presence for Knowledge Workers.

Action Resulting Change In Status

Manual change in UC-client.

The Knowledge Worker changes status manually in
the Lync or Skype for business client. Whatever
change is made is reflected in the Genesys
environment, with the emulated agent DN that
represents the Knowledge Worker being set to
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Action Resulting Change In Status
Ready, NotReady, or LoggedOut.

Knowledge Worker accepts a call.
On accepting a routed call from the contact center,
the Knowledge Worker's presence status is
changed in the UC-client to Do Not Disturb.

Knowledge Worker declines a preview.

If the Knowledge Worker declines the preview
interaction, the Knowledge Worker's agent status is
changed (by default) to the agent status of
NotReady.
After a configured NotReady timeout period (5 minutes by
default), the Knowledge Worker’s agent status is updated to
whatever their current presence status is on the Microsoft side.
For example, if the Microsoft status is still Online, then the
Knowledge Worker is put back into the Ready agent status.

Knowledge Worker is unavailable for contact-center
work.

The Knowledge Worker changes status to Do Not
Disturb in the UC Connector GUI. This sets their
Genesys agent status (by default) to NotReady, but
does not otherwise affect their presence status for
the enterprise.
While the Knowledge Worker is in this Genesys status, regular
Microsoft presence status changes are not mapped to changes
in agent status. Only once the Knowledge Worker indicates that
they are again Available to the Contact Center does regular
presence-to-agent status mapping apply.

Automatic change in UC Connector client

Microsoft Lync / Skype for Business can be
integrated with the user's calendar on Exchange
and so it is aware if the Knowledge Worker enters a
meeting or is out of office. When this happens, the
user's presence status is reflected in the
corresponding agent status in Genesys. Similarly,
Lync and Skype for Business clients detects when
the user has been idle for a while, and this is also
captured by the UC Connector.

Presence Integration with Microsoft Lync and Skype for Business

UC Connector communicates with Microsoft Lync and Skype for Business using MS-PRES (a Microsoft
protocol that extends SIP for presence) over TCP-IP and TLS. UC Connector connects to the Lync or
Skype for Business Front-End Server, directly or through a third-party load balancer. For more
information about supported deployments, see Supported Integrations.

UC Connector registers with the Microsoft server using SIP REGISTER requests, and the Front End
server responds with a 200 OK. After registration is completed, UC Connector subscribes to the status
of Knowledge Workers using SIP SUBSCRIBE requests, and the server responds with a 200 OK. This
occurs only when the Knowledge Worker logs in to the UC Connector tab in Office Communicator.

Whenever a change is made to the Knowledge Worker's presence status in Lync or Skype for
Business, the Front End Server sends a BENOTIFY (Best Effort NOTIFY, an MS-PRES message) to UC
Connector with the updated status. UC Connector changes the agent status for the Knowledge
Worker’s corresponding Genesys DN based on mapping rules.
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Presence Connector Mode

Starting with Release 8.0.3, UC Connector can be configured to map Genesys agent states to
Microsoft presence states, and then push the Microsoft presence state to Microsoft Lync / Skype for
Business as it changes in Genesys. This will enable Genesys users (for instance, Contact Center
Agents) to change Genesys agent state and have this visible to other Lync / Skype for Business users
in the Enterprise. The option presence-sync-mode controls whether UC Connector uses Presence
Integration mode, described in the section above, or the Presence Connector mode.

Push On-Call Status from Genesys to the UC Platform

When integrated into Lync or Skype for Business, UC Connector can push the telephony status of a
Knowledge Worker to the Microsoft side. If push-status functionality is enabled, when the Knowledge
Worker receives a call, UC Connector updates the Knowledge Worker UC status to the default Do Not
Disturb. This status setting is configurable (see oncall-status for Lync/Skype for Business).
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The Preview Window
UC Connector uses the Custom Server module, a Universal Routing Server (URS) component built into
the UC Connector itself, to handle the Preview interaction. By using the Custom Server module, UC
Connector processes proprietary CUSTOMLIB protocol messages sent from the routing strategy, in
order to initiate the Preview interaction with the third-party UC client.

HTTP is used as the transport method for both supported UC platforms.

The following diagram shows how the embedded Custom Server handles the Preview Interaction
between URS and the UC platform.

The Overall Preview Interaction

Depending on how the routing strategy is configured, the Preview interaction can be sent to a
particular individual Knowledge Worker, or in a round-robin manner (consecutively) to a pool of
available Knowledge Worker resources, continuing until one of them accepts the interaction. You can
also design the routing strategy to broadcast notifications to several Knowledge Workers in a group,
where the interaction is then sent to the first Knowledge Worker that accepts the preview.

The call flow for the overall interaction is as follows:

1. Customer interaction is initiated towards the Knowledge Worker
2. Based on the Knowledge Worker presence status in Genesys (possibly mapped from the corresponding

agent status on the Microsoft side), URS selects an available Knowledge Worker and initiates an
Interaction Preview with that user—the Preview window appears on their device. If the audio-on-
preview option is configured, the specified audio will also play to alert Knowledge Workers who may not
be at their desk that an interaction Preview has arrived.

3. A countdown timer appears in the preview window (the length of the timeout period is configurable).
The Knowledge Worker must respond before this timer runs out, otherwise the call is returned to URS,
where the strategy can select a new Knowledge Worker.

4. On accepting the Preview, an incoming call notification window appears on the Knowledge Worker
device (typically, the device is also ringing). If accepted, the voice call between customer and
Knowledge Worker is established.
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The Preview Notification Window

Shown below is a sample Preview window for an incoming voice call, as it appears on the desktop of
a Knowledge Worker. Information about the interaction also appears in the UC Connector GUI in
another browser window (not shown).

The Preview window can display any user information available to the routing strategy—in other
words, any customer information stored or collected earlier in the interaction, in order to give
relevant details of the interaction to the Knowledge Worker. In this case, customer information such
as phone number and service level are included.

Closing the Preview Window

This Preview window will close if the Knowledge Worker clicks the Accept or Reject buttons. It will also
close automatically if the Knowledge Worker fails to respond before the timeout period, or if the
interaction is canceled on the agent/customer end.
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The Interaction Window
When the interaction is accepted, the Interaction window or IM session interface will appear instead
of the Preview window, depending on the kind of interaction requested.

The following diagram shows the Interaction window, which allows the Knowledge Worker to see
information about the interaction and perform any call control actions they need (transfer, hold, and
so on). Because the window is browser based, it has the same appearance no matter which UC
platform is used.
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Reporting Events
UC Connector produces and sends reporting-related events for the Interaction Preview mechanism to
reporting platforms through the T-Server/SIP Server. To enable reporting, set the enable-preview-
reporting option to true in the uc-connector section of the UC Connector Application.

The feature is designed to be used with the ICON Custom Agent State feature, although other
reporting platforms can be used. For information on agent states, see both the Genesys Info Mart 8.1
User's Guide and 8.1 Deployment Guide.

The T-Library function TDistributeUserEvent is used to report Preview offers and completion results
for each Knowledge Worker offered an interaction Preview. UC Connector sends a request to T-Server
to distribute the corresponding event to all registered clients. A reporting application then makes
relevant detailed records upon receiving these events.

When there are invalid configuration parameters, the default values will be used.

Message Content

All events sent by UC Connector to T-Server will contain the following:

• ConID—Connection ID of the current call.
• ThisDN—The main DN of the Knowledge Worker.
• AgentID—The Knowledge Worker's Agent ID.
• UserData—This is the custom state-related information to be sent to T-Server/SIP Server.

The Preview offer will start the custom state identified by the key UCC_Preview and the number 3271,
which is customizable by the configuration option preview-state-name. The Preview offer event will
also record the associated ConnID using the key UCC_ConnID, and the Knowledge Worker's user ID
using the key UCC_UserId, and the Knowledge Worker's login ID using the key UCC_AgentId.

The Preview termination event will record the reason for the termination using the key UCC_Reason.
One of the following reasons will be recorded:

Accepted—The user accepts the interaction.

Rejected—The user explicitly rejects the interaction by pressing the appropriate button or key.

Timeout—The user does nothing while the interaction Preview is open.

Taken—Another user accepts the interaction. This can only occur in broadcast mode.

Error—An error occurred while showing the interaction Preview window.

Cancel—The interaction was abandoned by the original caller.
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Warning
The keys UCC_ConnId, UCC_UserId, UCC_AgentId, and UCC_Reason are configurable
with the option presence-gateway-mode.

Preview offer event User Data
UCC_Preview = "+"
UCC_ConnId = "3271, <ConnID(hex number)>"
UCC_AgentId = "3271, <agent_id>"
UCC_UserId = "3271, <user_id>"

Preview termination event User Data
UCC_Reason = "3271, {Accepted|Rejected|...}"
UCC_Preview = "-"
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Lync / Skype for Business Integration

Tip
An integration overview is presented below. For detailed integration information, see
UC Connector 8.0.3 Lync Integration Deployment Guide.

In integration with Microsoft Lync/Skype for Business, Knowledge Workers see the UC Connector user
interface on a browser window, or possibly in a Lync / Skype for Business conversation extension
window. Both these windows are web-based and allow the Knowledge Worker to control their UC
Connector presence status, to accept or reject interactions in the Preview window, and to control
ongoing chat or voice calls in the Interaction window.

There are two ways for the Knowledge Worker to access the UC Connector from the Lync / Skype for
Business client:

• The Knowledge Worker manually opens the UC Connector web client from the Tools menu.
• The Knowledge Worker accepts a Lync / Skype for Business preview interaction from UC Connector,

which opens the extension window.

Warning
If the Knowledge Worker uses Safari as their default browser, they must keep a
browser window open in order to receive previews for incoming interactions. If the
user closes the browser, alerts will not be received.

The Genesys UC Connector Web Client

In the Lync / Skype for Business client, under Tools, select Genesys UC Connector from the drop-
down menu to open the UC Connector web client.
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Using the drop-down menu, the Knowledge Worker can change their UC Connector presence status.
This status does not change if the Knowledge Worker then closes the web client.

While this window is open, an incoming interaction arrives as a regular UC Connector-based Preview
notification.

If this window is closed, an incoming interaction will arrive as a Lync / Skype for Business Preview
invitation. If this invitation is accepted, the UC Connector GUI opens in the conversation extension
window, followed by the UC Connector Preview notification. For more information, see How It Works.

The Lync / Skype for Business Preview Invitation

If the extension window or the UC Connector web client (see previous section) is not already open, a
new interaction will arrive at the Knowledge Worker's desktop using a native Lync / Skype for
Business chat request.
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If the Knowledge Worker accepts this invitation, the extension window opens.

The Conversation Extension Window

This window shows both the UC Connector tab as well as a Lync / Skype for Business chat window
used by the system to provide a configurable welcome message to the Knowledge Worker. This
window uses the invite-message option in the Microsoft-OCS section, which specifies the text that
will be presented to the Knowledge Worker in the conversation extension window when an interaction
arrives. The example below shows the extension window upon accepting an interaction.
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After the interaction is finished, the UC Connector tab remains open in the extension window. If the
Knowledge Worker keeps this window open, any new interaction will arrive as a separate web-based
Preview window. If the extension window is closed, new interactions will arrive once again as a native
Lync / Skype for Business chat request.
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Customized Help
UC Connector lets you create customized Help files that Knowledge Workers can access from the
web-based user interface. If enabled on a particular window, a clickable Help button appears,
providing a link to a .html help file that opens in the Knowledge Worker's browser. A sample .html
help file is included on the product CD, under Documentation/Help. You can use this file, or create
one of your own, stored at a network-accessible location.

You can specify a different help file for each of the following windows in the user interface:

• Login screen (help-login-url)
• Interaction window (help-interaction-url)
• Preview and Interaction windows (help-callcontrol-url, the same option is used for both windows)

For detailed procedures, see Customizing the Help Button.

The following figures show some sample screens where the Knowledge Worker can access an enabled
Help button.
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Customized Languages
UC Connector allows you to change the language used in the client interface. By default, UC
Connector uses English for the various tools and labels in the interface. Using the configuration
option locale, you can change the default language to one of several supported languages.

For configuration details, see Changing the Default Language.

The following figure shows a sample Interaction window localized for the French (fr) language.

List of Supported Languages

The following table lists the languages supported by UC Connector, as well as the two-character
country codes used to specify the language in the configuration.

Supported Languages Language Codes
English en
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Supported Languages Language Codes
French fr
German de
Italian it
Russian ru
Spanish (Latin America) es

When Other Languages May Be Used

If locale option is set to default, then UC Connector uses the language of the local operating
system provided it is included in the list of supported languages. If UC Connector integrates with a
web browser that uses a preferred language setting, then the web browser's preferred language
takes precedence over the internal UC Connector setting, again, only if the web browser language is
included in the list of supported UC Connector localizations.

If the locale option is not configured at all, then English is used as the absolute default.
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Customized Knowledge Worker States
UC Connector allows you to customize the states available to knowledge workers in the UC Connector
web client drop-down menu. The "agent states" and the corresponding text displayed in the menu
can be customized by editing application resources. This custom state functionality is only supported
in the standalone deployment mode. See standalone mode. If UC Connector is connected to an
external presences source, such as Microsoft Lync, the presence updates from Lync will override the
state set in T-Server.

Each customizable state is characterized by a unique combination of the major "agent state" (Ready
or Not Ready), the agent mode, and a reason code. The customized states can be made available for
display in the UC Connector web client drop-down menu. The customized states can also be used to
reflect the current user's state in the Channels tab.

Before release 8.0.300, UC Connector included two fixed states that mapped to the Genesys states
Agent Not Ready and Ready (without an agent mode or reason code):

• Do Not Disturb On
• Do Not Disturb Off.

In release 8.0.300, the UC Connector application is installed with these two states as an example in
the XML resource file. The states are also built in the application to enable default handling when the
resources are corrupted.

The editable XML resource file contains the state definitions and their corresponding visual
representation in the UC Connector web client menu, such as text strings, icons, and translations.
The provided example XML can be edited by the system administrator or integrator as required.

The XML file can be provided on the local file system or through HTTP(s) service. The HTTP(s) service
can be convenient for managing multiple instances of UC Connector for redundancy or load sharing.
The instance of Jetty web server packed with UC Connector can also be used to service this file and
its related resources, such as localization files, icons, and graphics. See Knowledge Worker in
Customing UCC Connector for details on the setup procedures.

Defining Knowledge Worker States

Each Genesys agent state in the XML file is composed of a unique combination of the following:
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• Main state—Ready or Not Ready. This is the "agent state" that will show up in real-time or historical
reporting.

• Agent mode—Manual, After Call Work, Legal Guard, Auxiliary Work, Walk Away, and Nodisconnect
• Reason code string—Afree-form text string that UC Connector attaches as a Reason or Extension

attribute with a user-defined key name to the corresponding agent state change request sent to T-
Server. The key name ReasonCode is used by default, but the name can be customized.

The agent mode and the reason code are optional.

UC Connector uses the definitions of the states to display the current user state in the agent status
indicator on the main panel and the corresponding channel state in the Channels tab of the UC
Connector web client. The appearance of the user state is defined by the icon and the status string
associated with the corresponding state definition.

To make custom state recognizable in the UC Connector web client, you must provide distinct
relevant icons. The system integrator is responsible for providing the corresponding artwork.

The text representation of the custom state can be defined in several languages simultaneously. UC
Connector transmits localized resources to the user's browser to be selected based on local
preferences.

When T-Server reports the agent state event, UC Connector matches the event against a set of
defined agent states. When the reported state is matched, UC Connector updates the corresponding
status indicators in the main panel and Channels tab of the UC Connector web client.

To display a non-matching agent state, UC Connector uses one of the predefined states that have no
matching elements defined. For example, UC Connector receives an event with the following:

• Agent state: Not Ready
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• Agent mode: After Call Work
• Reason code: 101

If UC Connector cannot match the reason code, it might use a definition for the Not Ready state with
an After Call mode and no reason defined. If it cannot match the reason code and the state, it might
use a definition for a plain Not Ready state without a mode.

UC Connector uses built-in plain Ready, Not Ready (previously called "DND on" and "DND off"), and
DND state definitions for states that cannot be matched against the XML file.

The system integrator is responsible for defining all the states that must be represented in the UC
Connector web client.

Warning
Some states, such as Not Ready with a work mode Legal Guard, cannot be requested
because they are controlled exclusively by T-Server or the PBX. Other states, such as
Not Ready with a work mode After Call Work, might not be compatible with a
particular T-Server or PBX. UC Connector does not validate the state definition. If the
state is defined as an available web client menu item, UC Connector attempts to use
it as defined, but the operation may fail if the target state is not supported by the T-
Server. The states that are controlled by T-Server and cannot be executed as an agent
command can still be defined in the XML document so that the corresponding status
can be displayed visually.

Multiple Channels
Users may have multiple channels provisioned in their place, but the UC Connector web client only
has one combined agent state indicator.

When a state change command is issued from the menu, UC Connector attempts to apply the same
agent state request to all channels. If all the resulting channel states map to the same defined state,
UC Connector displays and icon corresponding to that state. If the resulting channel states map to
different custom states, UC Connector updates the main agent status indicator in the web client with
one of the following predefined states:

partial-ready—at least one of the channels is in the "ready" state

not-ready—at least one channel is in the "logged in" state

logout—all channels are logged out

Warning
The indicator for an individual channel reflects the state of the channel only if the icon
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for the badge is supplied.
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External Number Redirect
A Knowledge Worker or an Administrator can enable an external redirect number, which allows
Knowledge Workers to accept preview calls at the specified number. When this features is enabled,
the UC Connector GUI has an additional control to set up the external number to use. This menu
option will only appear if the redirect-setup-enabled configuration option is set to true. Clicking on
the Setup option opens an additional window used to enter the phone number as shown below.

It is also possible for an Administrator to enable and set the redirect number for a person through
Genesys Administrator. See Enabling a Redirect Number on the Customizing UC Connector page. If an
external number has been configured, the preview window has a button to accept the incoming call
on that number.

If the user clicks the external number button, Universal Routing Server (URS) routes the call to the
specified redirect number. When the preview is accepted on an external number, the window is
modified to indicate the call is on an external number. If provisioned in the presence definition XML
document (see “How It Works—Customized Knowledge Worker States), UC Connector sets the user to
the preview-redirect auto-state after the redirect. The default target state after the redirect is dnd.
Remote call control is not possible at this point, and call notes (user data) cannot be edited or added.
When the user is ready to take the next call, they must first close the preview window and set the
user status to ready.
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Warning
The redirect number is not validated against premium rate, international numbers and
so on. It is the responsibility of the Administrator and the telephony platform to
validate if the user has permissions to redirect to the requested number.

Configuring an External Number

To configure an external number for preview, the user must select the Setup menu option.

This menu option will only appear if the redirect-setup-enabled configuration option is set to true. For
configuration details for this feature, see Redirect Number on the Customizing UC Connector page.

Selecting the Setup menu option opens the Setup Redirect Number window, where the user can set
or change the redirect number.

It is possible for an Administrator to enable and set the redirect number for a person through
Genesys Administrator. See Redirect Number on the Customizing UC Connector page.

Warning
The redirect number is not validated against premium rate, international numbers and
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so on. It is the responsibility of the Administrator and the telephony platform to
validate if the user has permissions to redirect to the requested number.
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Supported Integrations
The UC Connector supports Genesys contact center integrations with several versions of the
Microsoft Unified Communications platform. UC Connector supports Lync 2010, Lync 2013, and Skype
for Business (2015). This section describes how UC Connector can be deployed to integrate with
different configurations of Lync / Skype for Business. This section also describes using Workspace
Desktop Edition to present the agent side of the customer interaction.

• Functional Support
• Lync / Skype for Business
• Workspace Desktop Edition

Note: The references to third-party documentation in this document, including any URL or other web
references, are subject to change without notice. They are included for your convenience.
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Functional Support
UC Connector supports the same features in integration with all versions of the Microsoft UC platform,
be it Lync 2010, Lync 2013 or Skype for Business 2015.

The main supported functions are explained in this page.

• Presence monitoring: UC Connector uses the Microsoft proprietary MS-PRES protocol (augmented SIP/
SIMPLE) to subscribe to user presence from the Lync / Skype for Business Front End Server. This allows
the users' presence to be collected by UC Connector and mapped to Genesys presence.

• Presence push: UC Connector acts as a source of presence for its users, allowing to push useful
information to Lync / Skype for Business. This way, UC Connector can push the "in a call" status to
Microsoft when a user starts a call routed by Genesys, if so configured.

• IM through SIP Server-FE Server integration: SIP Server can act as an IM endpoint for Microsoft
Lync / Skype for Business, allowing both IM conversations from agents to knowledge workers (whole
presence is seen by agents through UC Connector) and incoming IM sessions to a route point for help
desk use cases from Lync / Skype for Business to Genesys agents.

• Interaction preview mechanism: UC Connector pushes a pop-up browser window to users when they
are targeted by an interaction preview. The browser window contains configurable information about
the incoming interaction, and can be accepted or rejected by the knowledge worker.

• Launching UC Connector if user is not logged in: UC Connector can send a special IM session to
Lync / Skype for Business formatted in a way to open a conversation extension window on the Microsoft
client, pointing a browser to the UC Connector main web page. This is useful if a knowledge worker is
presented with an interaction preview, but she doesn't have the UC Connector window open in her
browser.

• Secure connections (TLS): UC Connector supports TLS in integration with Microsoft Lync / Skype for
Business.
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Lync / Skype for Business

Tip
An integration overview is presented below. For detailed integration information, see
UCC 8.0.3 Lync Integration Deployment Guide.

The architecture of UC Connector integration with Lync or Skype for Business does not change with
the Microsoft versions; however, it changes depending on the configuration of the Microsoft platform.
In all cases, UC Connector links the Genesys environment and the Microsoft solution in the enterprise.
For presence, communication between UC Connector and Lync is through MS-PRES. For a complete
description of MS-PRES see http://msdn.microsoft.com/en-us/library/
cc431501%28v=office.12%29.aspx

The UC Connector does not play an active role in instant messaging communication with Lync / Skype
for Business. IM sessions are handled between Lync / Skype for Business and SIP Server exclusively,
over SIP.

However, for integration with the Microsoft Lync / Skype for Business Client, the UC Connector is able
to send a special IM message that starts a context-sensitive IM conversation in the Lync or Skype for
Business client. The special IM prompts the Lync or Skype for Business client to open the
conversation extension window, in which a browser window points to the UC Connector GUI. This is
done only if the UC Connector GUI is not already open on the target user’s desktop.

Supported deployments with Microsoft Lync / Skype for Business include:

• Deployment with Microsoft Lync Skype for Business Standard Edition
• Deployment with Microsoft Lync Skype for Business Enterprise Edition
• Deployment with Microsoft Lync / Skype for Business Enterprise via Edge Server

For information on the above deployments, see the UCC 8.0.3 Lync Integration Deployment Guide.
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Workspace Desktop Edition
For the purposes of this guide, the agent side of the customer interaction is presented using
Workspace Desktop Edition 8.5. Workspace Desktop Edition provides the functionality required to
give agents access to experts outside the contact center. This functionality includes:

• Showing a group of Knowledge Workers in the Workspace Desktop Edition Buddy List (the group will
appear as a regular agent group).

• Showing an individual Knowledge Worker in the Workspace Desktop Edition Buddy List (the KW will
appear as a regular agent).

For more information about using the Buddy List, consult the Workspace Desktop Edition 8.5
Deployment Guide and the Workspace Desktop Edition 8.5 User’s Guide. If you are using previous
versions of Agent Desktop, or a customized agent client using the Genesys SDK, some modifications
may be required to achieve the above functionality. Consult the Workspace Desktop Deployment
Guide for your version of the product, or the Genesys SDK used to create your custom agent client.

Next, integrate UC Connector with Lync / Skype for Business, if part of the environment.

Supported Integrations Workspace Desktop Edition

UC Connector Deployment Guide 62



Deployment Task Table
The following table summarizes the deployment tasks that are required to deploy the UC Connector
into the Genesys environment, as well as how to integrate the deployment with the Microsoft Unified
Communications platform (Lync or Skype for Business) on the enterprise side:

Complete the following tasks to deploy and integrate the UC Connector solution.

Objective Actions

1. Complete prerequisites.

• Configuring the Baseline Genesys Environment
• Install Java
• Host Requirements
• Deploy the Third-party UC Platform
• Configure the Microsoft UC Platform to work

with UC Connector

2. Deploy the UC Connector. • Deployment Procedures

3. Configure the Knowledge Worker. • Configure Knowledge Worker DNs, Logins,
Places, Persons.

4. Integrate with the agent's desktop. • Integrate with Workspace Desktop Edition.

5. Integrate with Genesys Routing
• Create Custom Server Application, configure

routing from contact center, configure contact
point for Knowledge Worker.

6. (optional) Enable Instant Messaging (Genesys IM
Integration)

• Verify the Genesys IM solution.
• Configure the Knowledge Worker DN.

7. (optional) Enable Instant Messaging (SIP - Lync /
Skype for Business Integration)

• See the UC Connector 8.0.3 Lync Integration
Deployment Guide, SIP Server Configuration.

8. (required for Lync / Skype for Business) Enable
Secure Communication • See Enabling Secure Communications.
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Baseline Environment
Before you begin the UC Connector integration, all baseline components must be installed and
configured. For Genesys components, consult the product Deployment Guides as outlined in the
section below. For the enterprise UC solution-related components, consult the third-party product
documentation described in the section below.

This chapter contains the following sections:

• Configuring the Baseline Genesys Environment
• Installing Java
• Host Requirements
• Deploying the Microsoft UC Platform
• Configuring the Microsoft UC Platform to work with UC Connector

Important
The references to Microsoft documentation in this section, including any URL or other
web references, are subject to change without notice. They are included for your
convenience.

Configuring the Baseline Genesys Environment

The following table lists the prerequisite Genesys components, their respective Deployment Guides,
as well as key actions that you must complete before starting the integration procedures.

Component Key Actions Documentation

Management Framework 7.5+
A centralized Genesys
Management Framework, with all
required components, must be
installed.

Framework 8.1 Deployment
Guide

Genesys Administrator

After installing Genesys
Administrator, login to the tool:

1. Open a web browser and
enter the following URL:
http://<computer_name>/wc
m/Default.aspx

2. Enter the following
information:

Genesys Administrator 8.1
Deployment Guide
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Component Key Actions Documentation

• User name
• User password
• Application (name of the

Configuration Server in
database)

• Host name (Configuration
Server host)

• Port (Configuration Server
port)

3. Click Log in

Tip
Genesys Administrator or
Configuration Manager can be used
to configure UC Connect.

Configuration Manager

On a computer installed with
Configuration Manager, login to
the tool:

1. Start > Programs >
Genesys Solutions >
Framework > Configuration
Manager > Start
Configuration Manager

2. Enter the following
information:
• User name
• User password
• Application (name of

Configuration Server in
database)

• Host name (Configuration
Server host)

• Port (Configuration Server
port)

3. Click Ok.

Tip
Genesys Administrator or
Configuration Manager can be used
to configure UC Connector.

Framework 8.1 Deployment
Guide

T-Server Required for integration with
various switches or PBXs.

See the Deployment Guide for
your respective T-Server.
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Component Key Actions Documentation

Important
The T-Server and associated switch
MUST support emulated-agent
functionality for integration with UC
Connector.

For more information on which T-Servers
support emulated-agent functionality, see
T-Server Compatibility with UC Connector.

SIP Server version 8.0.300.00 or
later

Required for the following
deployments:

• Instant Messaging
functionality with Microsoft
Lync / Skype for Business

Framework 8.1 SIP Server
Deployment Guide

Universal Routing Server

Required for routing to agents
and for handling the contact
center-to-Knowledge Worker
interaction.
Required connections:

• Message Server
• SIP Server Application

object (if included)
• Any other T-Server Application

that is included your
deployment.

• Stat Server
• Custom Server

Universal Routing 8.1
Deployment Guide and Universal
Routing 8.1 Reference Manual

Interaction Routing Designer

Required for building the URS
routing strategies that control
the interaction between the
contact center and Knowledge
Workers.
Note: IRD is the only Genesys tool that
supports UC Connector routing strategies
development.

Universal Routing 8.1 Business
Process User's Guide and
Universal Routing 8.1 Interaction
Routing Designer Help

Workspace Desktop Edition 8.1+

Starting with release 8.5.0,
Genesys Interaction Workspace is
known as Genesys Workspace
Desktop Edition.
Required for a desktop workspace that
the contact center agent uses to initiate
interactions with the Knowledge Worker.
For Workspace Desktop Edition 8.1 and
above, required functionality is included
in the default deployment. For other
Desktops, some additional configuration
may be required. See Integrating with
Workspace Desktop Edition.

Interaction Workspace 8.1
Deployment Guide

Stat Server 7.6+ Required for monitoring the Framework 8.1 Stat Server
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Component Key Actions Documentation
availability of agents and
emulated agents (Knowledge
Workers) targeted in the routing
strategies.
Required connections:

• Message Server
• SIP Server Application

object (or T-Server)

Deployment Guide

Installing Java

UC Connector requires that you install a Java Software Development Kit (JDK). UC Connector support
JDK 8.0 (release 1.8.0+).

The following table provides basic information about installing the JDK on the host Windows Server.

Objective Key Actions

1. Download the JDK version 8.0.

Download the JDK 8.0 to your host computer (see
Operating System UC Connector Host section
below). At publication of this document, JDK 8.0 is
available for download here:
http://www.java.com/en/download/

2. Configure Environment Variables.
Make sure the JAVA_HOME environment variable
points to the directory where you installed the JDK,
for example: c:\jdk1.8.0

Host Requirements

Operating System—UC Connector Host
For installation of the UC Connector application on the host computer, UC Connector 8.0 currently
supports the following operating systems:

• Windows Server 2008, 32-bit and 64-bit
• Windows Server 2008 R2, 64-bit
• Windows Server 2012, 64-bit
• Windows Server 2012 R2, 64-bit
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Web Browser—Knowledge Worker Host
UC Connector 8.0 integrates with the web browser on the host Knowledge Worker computer. UC
Connector currently supports integration with the following web browsers:

• Windows Internet Explorer 8.0, 9.0, 11.0
• Firefox 3.5 and higher – last version tested at the time of the writing: 45
• Google Chrome

Deploying the Microsoft UC Platform

The installation and deployment of the Microsoft UC platform that can integrate with UC Connector is
beyond the scope of this document. If you are performing an end-to-end deployment (the UC
platform is not already installed), the following table details where you can go for more information
about setting up the UC platform.

Task Description Details

Deploying the Server

The Microsoft Lync / Skype for
Business Servers must be
installed and configured
according to the required
topology. This may include:

• Load balancers for handling
traffic.

• Edge Servers for authorizing
Genesys contact center
access to the enterprise UC
platform.

For details, consult the following
Microsoft Lync / Skype for
Business Server documentation:
http://technet.microsoft.com/en-ca/
library/gg398616.aspx

Deploying the Client

Microsoft Lync / Skype for
Business Client must be installed
on the Knowledge Worker
device(s). In order to enable
launching the UC Connector GUI
from the Lync / Skype for
Business Client in different
settings, there are some registry
keys that must be set.

For details, see the Modifying the
Registry for Microsoft Lync.

Secured Mode
For Microsoft Lync / Skype for
Business Server, secured
communication is mandatory.

For details see Enabling TLS/
Kerberos Secure Communication.

Supported Architectures
For information about supported
Lync / Skype for Business
architectures, see Lync / Skype
for Business.
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Configuring the Microsoft UC Platform to work with UC Connector

The configuration of the Microsoft UC platform (Lync or Skype for Business) required for a UC
Connector integration is detailed in the UC Connector 8.0.3 Lync Integration Deployment Guide.
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Deployment Overview
This chapter summarizes how to deploy the UC Connector, and how to integrate the UC Connector
into the rest of the Genesys environment. Detailed procedures are given in the next chapter.

• Deploying the UC Connector
• Configuring the Knowledge Worker
• Integrating with Workspace Desktop Edition
• Integrating with Genesys Routing
• Enabling Instant Messaging
• Enabling Secure Communication
• Customizing UC Connector

Also see Deployment Modes.
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Deploying the UC Connector
The following table provides an overview of the main steps that you must complete in order to deploy
the UC Connector into the Genesys environment.

Objective Actions

1. Verify the baseline Genesys configuration.

If the UC Connector is deployed together with a Genesys
Contact Center installation, check that the following prerequisite
components are deployed:

• Management Framework (LCA, Configuration
Server, Message Server)

• Universal Routing Server
• Stat Server
• T-Server (it could be SIP Server as well)
• SIP Server (for Instant Messaging scenarios)
• Workspace Desktop Edition (optional. Other

agent desktop clients can also be used)
If the UC Connector is used without a Contact Center, install the
following components that come with the UC Connector bundle.
The components should be installed within the same subnet.
Refer to the respective deployment guides for installation
information.

• Management Framework (LCA, Configuration
Server, Message Server)

• Universal Routing Server
• Stat Server
• The appropriate T-Server for the deployed PBX
• SIP Server (for Instant Messaging scenarios)

For more information, see Configuring the Baseline Genesys
Environment.

2. Create Host.

Create a Host object for the computer on which you will later
install the UC Connector on (if one has not been created
already).

Supported Operating Systems:

• Windows Server 2008 32/64 bit
• Windows Server 2008 R2 64 bit
• Windows Server 2012 64-bit
• Windows Server 2012 R2 64-bit

Deployment Overview Deploying the UC Connector

UC Connector Deployment Guide 71



For more information about creating hosts, see the Framework
8.1 Deployment Guide.

3. Import the application template.

1. Go to Environment > right-click Application Templates >
Import Application Template

2. Select the UC_Connector_800.apd template available on the
product CD.

For more information, see Framework 8.1 Deployment Guide.

4. Create the UC Connector Application object.

1. Create the UC Connector object from the imported .apd
template.

2. Add a SIP listening port—typically 5060 (required for
integration with Lync Server only).

3. Add connections to:

• Custom Server (see Integrating with Genesys
Routing).

• T-Server
• Stat Server

For more detailed instructions, see Creating the UC Connector
Application Object.

5. Install the UC Connector.

On the host computer, launch the setup.exe file
available on the product CD.

The installation path must not include any spaces. Genesys
recommends installing to the default path:
C:\GCTI\UCConnector Key Action

• Take note of the HTTP port that you enter in the
installation wizard. You will have to specify this
port in web page customization later in the
deployment.

For more detailed instructions see, Installing the UC Connector
Server on the Host.

6. Configure the UC Connector section.

Use the options in the UC-Connector section to enable notes,
customize interaction windows, configure timeouts, and other
features.

None of these options are mandatory (default values are
acceptable; some features may not be enabled).

For a detailed list of UC-Connector options, see UCC Application
Options.

DN/Switch-level settings (configured on the KW Person
object) take precedence.
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7. Configure the Log section.

In the Log section, configure the log-related options as you
would for any other Genesys application.
There is one UC Connector-specific log option:

• internal

For more information, see the Framework 8.5 Deployment
Guide.

8. Configure the Lync / Skype for Business section.

Configure the following section:

• Microsoft-OCS

This configures both Lync and Skype for Business integration.
For details, see UCC Application Options.

DN/Switch-level settings (configured on the KW Person
object) take precedence.

Optional Customization

• Edit Help Buttons—You can enable a help button
on various UC Connector screens, with links to a
customized help file. For details, see Help
Buttons in Customizing UC Connector.

• Set Default Language—You can set the default
language for the UC Connector user interface.
For details, see Default Language in
Customizing UC Connector.

• Enable Automatic Log-in—To automatically log
in all Knowledge Workers on UC Connector start
up:
• In the uc-connector section of the UC

Connector Application object, set the option
user-auto-registration to true.

This is required for integrations with Microsoft Lync Server.

• Enable Logout Menu—To display the logout
menu in the GUI, in the uc-connector section
of the UC Connector Application object, set the
option enable-logout-menu to true.

• Enable Audio on Preview or Ringing—You can
enable an audio file to play when the Preview or
Ringing pop-up window is displayed. For details,
see Audio in Customizing UC Connector.

• Configure Hotkeys for Interaction Preview—You
can set specific keys to accept or reject a call
when the Preview window is displayed. For
details, see Hot Keys in Customizing UC
Connector.

• Customize Agent States—You can define custom
presence states for the UC Connector Web
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Client with an XML resource file. For details, see
Knowledge Worker in Customizing UC
Connector.

• Enable Number Redirect—You can allow agents
to change their own external redirect number
and accept preview calls on that number. For
details, see Redirect Number in Customizing UC
Connector.
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Configuring the Knowledge Worker
The Knowledge Worker must be configured on both the Genesys side and on the Microsoft side, if
integrating with Lync / Skype for Business.

On the Genesys side, you configure a Person object for each Knowledge Worker, so that the
Knowledge Worker is treated by the contact center as an agent, with access to all business rules,
routing, and reporting available to a regular agent. You must also create an Extension DN object for
each Knowledge Worker who is to be integrated into the contact center.

About Emulated Agent Functionality

For integrations with T-Server, you must configure the Knowledge Workers as "emulated" agents.
Consult the Deployment Guide for your respective T-Server for more information about configuring
emulated agents.

Configuring Do Not Disturb Status at Login
UC Connector relies on T-Server/SIP Server to determine the Do Not Disturb status of the Knowledge
Worker when they log in. You can define this status by setting the relevant T-Server/SIP Server
options that are used to control whether emulated agents are logged in to the Ready or NotReady
state.

Some T-Servers might not support defining this behavior using configuration options. In this case, the
Do Not Disturb status of the Knowledge Worker at login cannot be defined. Consult the Deployment
Guide for your T-Server for information about how to configure this feature.

After Call Work is Not Supported
UC Connector does not support After Call Work (ACW) time for Knowledge Workers. Ensure that ACW
in the Agent Login for the Knowledge Worker is disabled (set wrap-up-time to 0).

Configuring the Knowledge Worker

The following table describes the basic steps required to configure the Knowledge Worker on the
Genesys side.

Objective Actions

1. Create KW DNs.
Create an Extension DN for each Knowledge Worker you want to
integrate into the contact center.
For information about configuring Extensions, consult the
respective Deployment Guide for your T-Server.
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2. Create Agent Logins.
1. In the Agent Login folder under the Switch, create an Agent
Login object for each Knowledge Worker.
2. On the General tab, enter an agent login ID in the Code field.
You will link to this agent login when you create the Person
object for the Knowledge Worker.

3. Configure Places.

1. Create a Place object for each Knowledge Worker.
2. Add a shortcut to the DN you created in Step 1.
For a detailed procedure, see the Creating the Knowledge
Worker Place in Genesys Administrator in :

• Configuration Database Procedures.

4. Create Knowledge Worker Persons.

Each Knowledge Worker requires a Person to be created in the
contact center.
1. For each KW, create a Person object.
2. On the General tab, define a user name and password
(which you will use later to log into the UC Connector interface
in the client).

Format depends on how <userid> is configured in the
custom tab .xml file. See Modifying the Custom Tab File in
Configuration Database Procedures.

3. In the Annex tab, UC-Connector section, configure the
following option:enabled.
4. In the Microsoft-OCS section, configure the following options:

• agent-status-ready (optional)
• agent-status-notready (optional)
• agent-status-logout (optional)
• contact

5. For each Person, on the Agent Info tab:

• Configure a default Place.
• Assign the Login ID that you created in Step 2.

For details, see Creating the Knowledge Worker Person in
Genesys Administrator in

• Deployment Procedures.
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Integrating with Workspace Desktop
Edition
For the purposes of this guide, the agent side of the customer interaction is presented using
Workspace Desktop Edition 8.5. Workspace provides the functionality required to give agents access
to experts outside the contact center. This functionality includes:

• Showing a group of Knowledge Workers in the Workspace Buddy List (the group will appear as a regular
agent group).

• Showing an individual Knowledge Worker in the Workspace Buddy List (the KW will appear as a regular
agent).

For more information about using the Buddy List, consult the Workspace Desktop Edition 8.5
Deployment Guide and the Workspace Desktop Edition 8.5 User’s Guide.

If you are using previous versions of Agent Desktop, or a customized agent client using the Genesys
SDK, some modifications may be required to achieve the above functionality. Consult the Agent
Desktop Deployment Guide for your version of the product, or the Genesys SDK used to create your
custom agent client.
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Integrating with Genesys Routing
Genesys routing is used to handle transfers and conferences both to and from the Knowledge Worker.
For agent transfers to the Knowledge Worker, the routing strategy must be designed to include the
Preview Interaction, and the Routing Point DN—or DNs—should be accessible to the agent desktop.
For Knowledge Worker transfers to the contact center, special "contact points" must be created in
Genesys. These contact points (Routing Point DNs) are then exposed in the UC client Interaction
window, so that Knowledge Workers can send calls back to the contact center for further processing.

The following table describes the main steps required to enable Genesys routing to and from
Knowledge Workers.

Objective Actions

1. Create a "dummy" Custom Server Application
object.

1. Import the Custom_Server_800.apd application template.
2. Create the Custom Server Application object with the same
host as UC Connector.

Key Rules

• Do not install the Custom Server .exe file. Only
the dummy application is required in the
Configuration Layer. This is because an instance
of the Custom Server is included with the UC
Connector executable.

• Create one dummy Custom Server for each
instance of UC Connector.

• For HA deployments, deploy one dummy
Custom Server for each HA UC Connector pair.
For more information, For details, see Creating
the Customer Server Application Object in
Configuration Database Procedures.

2. Connect UC Connector to Custom Server.

Add connections to Custom Server in both UC Connector and
URS Application objects:

• On the Connections tab of the Application
object, Add and browse for the Custom Server
object you created in Step 1.

• Do this for both UC Connector and URS.

3. Configure a contact point for the Knowledge
Worker.

1. Configure a Routing Point DN as the contact point that
Knowledge Workers can use to transfer/conference interactions
back to the contact center. Add the following options to the
Annex tab:

• enabled—Set this option to true.
• display-name—Set this option to the name that

will be displayed in the Interaction window. For
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example, Contact Center.
• attribute<n>—Set this option to the statistics

you want to make available for this contact
point.

For details, see Configuring contact points in Configuration
Database Procedures.
2. Create a routing strategy that handles agent selection in the
contact center, and load it on this DN. Preview Interactions for
transfers to agents are not required.

Key Rules

• Create a separate Routing Point DN for each
contact point that you want to appear in the
Interaction window.

4. Configure routing from contact center to
Knowledge Worker.

• Configure Routing Points for contact center
agent transfers to the Knowledge Worker.

• Create and load the routing strategies that will
direct transferred calls to the Knowledge
Worker.

Sample Strategies

For sample strategies that you can import or use as a model for
your own strategies, see the following:

• Routing to a Particular Knowledge Worker
• Routing with Round-Robin Selection
• Routing with Broadcast Preview
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Enabling Instant Messaging
Instant Messaging (IM) functionality is available through either of the following configurations:

• Integration with Genesys Instant Messaging (IM)
• SIP Server integration with Microsoft Lync / Skype for Business

Pros and Cons

The following table describes the advantages and disadvantages of the supported IM configurations.

Genesys IM Integration SIP Server-Lync / Skype for Business
Integration

* Platform-independent
Can be used regardless of Microsoft Integration and also in
stand-alone mode..

* Limited to Lync / Skype for Business deployments.

* Inbound IM only.
The Knowledge Worker can only accept incoming IM sessions.
They cannot initiate new IM sessions with the contact center.

* Inbound and outbound IM.
The Knowledge Worker can both accept incoming IM sessions,
as well as initiate new IM sessions with the contact center.

* Simplified configuration.
You can configure a single DN to support both voice and IM
interactions.

You can still choose to keep the interactions on separate
DNs— for example, to separate voice and chat traffic across two
separate switches.

* Multiple DNs required.

• Lync / Skype for Business integration with SIP
Server requires a separate Knowledge Worker
DN for voice and IM. It also requires a special
DN to handle the direct connection between SIP
Server and the Font End Server for IM.

* UCC-controlled IM window. * Lync / Skype for Business-controlled IM window.
* T-Library
With UC Connector, chat through Genesys IM is controlled by
the T-Library interface. This allows UC Connector to manage the
IM session.

* SIP
Chat is provided through the SIP interface.

Enabling Genesys IM
The following table shows the main steps required to integrate the UC Connector with SIP Server for
IM functionality, in a UC Connector deployment.

Objective Actions

1. Verify the Genesys IM solution. The Genesys IM Solution uses many of the same prerequisite
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Genesys components as those used by UC Connector:

• Genesys Stat Server
• Universal Routing
• Interaction Workspace or customized desktop

These components should already be installed and configured
as part of the prerequisites for deploying UC Connector.

Genesys IM also requires:

• SIP Server
For more information, see:

• Genesys 7.6 Instant Messaging Solution Guide
• Framework 8.1 SIP Server Deployment Guide

2. Configure the Knowledge Worker DN.

Configure the Knowledge Worker Extension DNs with the
following options:

• multimedia—Set this option to true to allow IM
interactions.

• sip-signaling-chat—Set this option to none
so that UC Connector handles the IM
interaction.

• voice—(Optional) Set this option to false for
DNs that will only provide chat functionality.
(For example, if you are separating chat and
voice traffic across different switches).

Sample DNs:

• Single DN for Both Chat and Voice
• Separate Chat-Only DN

3. (Optional) Customize the Chat window.

You can customize the name for the Chat window. In the UC
Connector Application, on the Options tab, UC-Connector
section, you can configure the following options:

• chat-title—Enter the name you want to
appear in the regular chat window.

• chat-consult-title—Enter the name you
want to appear in the window that appears for
consultation chat interactions.

Single DN for Both Chat and Voice

You can modify an existing Knowledge Worker voice DN to also handle the chat interaction. Or you
can create a separate DN that handles chat only. This diagram shows a DN that handles SIP voice
plus SIP instant messaging (the sip-signaling-chat option is set to none).
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Separate Chat-Only DN

This diagram shows what this same DN object’s options might look like if you intended for it to handle
SIP instant messaging only (the sip-signaling-chat option is set to none, and the voice option is
set to false).

Next Steps:

• If you do not require secure communication in the deployment, continue with Configuring the Routing
Strategies.
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• If secure communication is required, continue at one of the following:
• Enabling MTLS Communication
• Enabling TLS/Kerberos Secure Communication

Enabling IM through SIP Server and Microsoft Lync / Skype for Business Server
The following table shows the main steps required to integrate SIP Server with the Front End Server
for IM functionality, in a UC Connector deployment.

Objective Actions

1. Install and configure SIP Server.

SIP Server is mandatory for Instant Messaging.
If SIP Server is not already part of your deployment, install and
configure SIP Server according to the procedures described in
the Framework 8.1 SIP Server Deployment Guide.

No special configuration in the SIP Server Application object
is required for IM.

2. Integrate SIP Server with Lync / Skype for
Business Server.

Complete all the steps for Presence Integration with Microsoft
Office Communications Server 2007, as described in the
Framework 8.1 SIP Server Deployment Guide.
These steps include:

• Creating a Routing Point and adding a user for it
in Lync / Skype for Business Server. Used for
presence integration.

• Configuring a Trunk DN for the Lync / Skype for
Business Server.

• Configuring Extension DNs for each Knowledge
Worker, to be used for IM interactions only.

Do not configure the ocs-dn option in the Extension DN.
Presence is handled through UC Connector.

3. (Optional) Customize the Chat window.

You can customize the name for the Chat window.
In the UC Connector Application, on the Options tab, UC-
Connector section, you can configure the following options:

• chat-title—lnter the name you want to
appear in the regular chat window.

• chat-consult-title—Enter the name you
want to appear in the window that appears for
consultation chat interactions.

Next Steps:

• If you do not require secure communication in the deployment, continue with Configuring the Routing
Strategies.

• If secure communication is required, continue to one of the following:
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• • Enabling MTLS Communication
• Enabling TLS/Kerberos Secure Communication
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Enabling Secure Communication
UC Connector supports the Kerberos protocol for establishing secure connections—using simple
Transport Layer Security (TLS) or Mutual Transport Layer Security (MTLS)—between the UC Connector
application and Microsoft Lync/Skype for Business Front End Server. Kerberos is required for
integrations with the Front End Server to act as a client. MTLS is required to push presence status to
Lync / Skype for Business.

About TLS/Kerberos Security

Kerberos is a secure method for authenticating a request for a service in a computer network. If
configured for TLS/Kerberos secure communication, when UC Connector registers with Microsoft Lync
/ Skype for Business (by sending a SIP REGISTER request), the server will use Kerberos authentication
procedures to send sip 401 Unauthorized or sip 407 proxy authentication required in the
following cases:

• UCC is using regular TCP connection, and the UC Connector host IP address has not been added to the
Trusted Host list.

• UCC is configured to use TLS connection.

To configure TLS/Kerberos, see the Kerberos information in the UC Connector 8.0.3 Lync Integration
Deployment Guide, Security Procedures.

About MTLS

If configured for Mutual Transport Layer Security (MTLS), a shared trusted Certificate Authority (CA)
on both the UC Connector host and the Lync deployment are used to establish secure
communication. The certificates prove the identity of each server to the other.

To configure MTLS, see the UC Connector 8.0.3 Lync Integration Deployment Guide, Security
Procedures.
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Customizing UC Connector
UC Connector supports the following customization:

• Help Button—Enable the Help buttons on various UC Connector client windows.
• Default Language—Modify the language used in the UC Connector user interface.
• Audio—Enable an audio file to play when UC Connector displays a Preview or Ringing pop-up window.
• Hotkeys—Configure hotkeys to control accepting or rejecting a call when UC Connector displays the

Preview window.
• Knowledge Worker States—Customize the “agent states” displayed in the UC Connector Web Client

drop-down menu.
• Redirect Number—Enable a Knowledge Worker or Administrator to define an external telephone number

to recieve interactions.
• After Call Work—Enable a Knowledge Worker to enter the After Call Work state.

Help Buttons

Customizing the Help Buttons

The following table describes the steps required to enable an active Help button in the various UC
Connector client windows. For general information about this feature, see Customized Help.

Objective Related Procedure and Action

Customize the Help Buttons.

In the UC-Connector section of the UC Connector Application
object, configure any of the following:

• help-login-url—Enter the path the Help file for
the Login screen. For example, the path to the
sample help file is: /help/login.html

• help-interaction-url—Enter the path to the
Interaction window Help file. For example,
/help/interation.html.

• help-callcontrol-url—This configuration applies
to both the Preview and Interaction windows.
For example, /help/callcontrol.html.

Key Notes

• Sample help files are included on the product

Deployment Overview Customizing UC Connector

UC Connector Deployment Guide 86



CD. You can find them under the
documentation/help folder.

• You can move these sample help files to a
network-accessible location (point the help-url
options to this location). Or you can create help
files of your own.

• By default, these options are not configured. You
can enable any or all of these buttons. Only if
enabled will a particular Help button appear.

• For external help files, use a fully qualified URL.
For example, http://www.companyhelp.com.

Default Language

Changing the Default Language

The following table describes the steps required to modify the language used by the UC Connector
client interface. For general information about this feature, see Customized Languages.

Objective Related Procedure and Action

Change the Default Language.

In the UC-Connector section of the UC Connector Application
object, configure the following:

• locale—Enter a two-character language code.
For example, the default language (English)
uses the code en.

For a list of supported languages and character codes, see
Supported Languages.

Audio

Enabling Audio on Preview or Ringing

The following table describes the steps required to enable an audio file to play, in a loop, when UC
Connector displays a Preview or Ringing pop-up window.

Objective Related Procedure and Action
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Enable audio when a preview or ringing pop-up is
displayed.

In the UC-Connector section of the UC Connector Application
object, configure one of the following:

• audio-on-preview—Enter the location of the
audio file. For example, a file path to the UC
Connector installation or a URL to some other
network-accessible location.

• audio-on-ring—Enter the location of the audio
file. For example, a file path to the UC
Connector installation or a URL to some other
network-accessible location.

Key Notes

• To specify the location of a file in the UC
Connector installation, place the file in the UCC-
install/webapps directory or any of its
subdirectories. For example, if an audio file
'ring.mp3' is placed in UCC-install/webapps/
audio/, then the value for the audio-on-ring
or audio-on-preview option should be /audio/
ring.mp3.

• These options are only applicable when UC
Connector is used in non-gateway mode
(presence-gateway-mode is set to false).

• This feature supports .mp3, .ogg and .wav
formats, but not all audio formats are supported
by all browsers. HTML5 is used to play the
audio file, which is not supported by Internet
Explorer 8. For information on audio formats
and browser support as of the time this
document was last updated, see the Audio
Formats and Browser Support table.

Browser Support
Audio Formats and Browser Support

Browser MP3 Wav Ogg
Internet Explorer 8 No Yes No
Internet Explorer 9+ Yes No No
Firefox 4.0+ No Yes Yes
Google Chrome 6+ Yes Yes Yes
Apple Safari 5+ Yes Yes No

Hotkeys
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Configuring Hotkeys for Interaction Preview

The following table describes the steps required to configure hotkeys to control accepting or rejecting
a call UC Connector displays the Preview window.

Objective Related Procedure and Action

Configure hotkeys for interaction preview.

In the UC-Connector section of the UC Connector Application
object, configure the following:

• preview-shortkey-accept—Set to an alpha-
numeric or ASCII number format to represent
the key used to accept the call when the
Preview window is displayed.

• preview-shortkey-reject—Set to an alpha-
numeric or ASCII number format to represent
the key used to reject the call when the Preview
window is displayed.

Key Notes

• The user is still able to click the corresponding
buttons in the Preview window.

• The Preview window must be in focus for the
hotkeys to function.

• ASCII decimal number format—The string must
start with a hash (#) as the first character:
• #32

Only a single digit can be processed with this ASCII decimal
number format.

• Alpha-numeric format—The number of
characters should not exceed 255, and the first
character ‘#’ should be specified as ‘##’.The
string can be a combination of uppercase and
lowercase characters representing a single
keystroke:
• QqWwEeRrTt

Knowledge Worker States

Customizing Knowledge Worker States

The following table describes the steps required to configure customized Knowledge Worker states
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and display customizable menus. For general information about this feature, see Customized
Knowledge Worker States.

Objective Related Procedure and Action

1. Modify or override the presence definition
document.

The UC Connector application is initially installed with a default
presence definition document called presence.xml file. This file
contains the two states available in releases prior to 8.0.300:

• Set Do Not Disturb On
• Set Do Not Disturb Off

You can modify this file or create your own XML file to override
the default. See Presence definition document for details.

2. Enable customized Knowledge Worker states.

In the UC-Connector section of the UC Connector Application
object, configure the following:

• presence-location—Set to the location of the
presence.xml file.

Redirect Number

Enabling a Redirect Number

The following table describes the steps required for either a Knowledge Worker or an Administrator to
enable an external redirect number. Enabling this feature allows Knowledge Workers to accept
preview calls at the specified number. For general information about this feature, see External
Number Redirect.

Objective Related Procedure and Action

Enable the redirect setup.

To allow all users to set and enable their own redirect number
using the Setup menu option in the UC Connector web client:

• In the UC-Connector section of the UC
Connector Application object, set the option
redirect-setup-enabled to true.

To allow a specific user to set and enable his or her own redirect
number:

• In the Persons > Annex > UC-Connector
section, set the option redirect-setup-
enabled to true. This option overwrites the
value of the application-level redirect-setup-
enabled option.
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To set and enable the redirect number for a Person:

• In the Persons > Annex > UC-Connector
section, set the redirect-number option to the
number.

• In the Persons > Annex > UC-Connector
section, set the redirect-enabled option to
true.

After Call Work

Enabling After Call Work

When an agent enters the After Call Work state, the agent's presence state is preserved in Genesys
until the agent uses the Lync client menu to change state, or the After Call Work timer expires. The
agent’s presence state is also propagated to the Lync server so that the agent's unavailability is
reflected in the corresponding Lync presence, with a configurable presence status and note values.

When the agent exits the After Call Work state (either automatically or manually), the agent's Lync
presence state is set back to a value that is preserved from the Lync presence update. The agent's
Genesys state is also updated with the corresponding value.

The following table describes the steps required to configure the presence and note values for the
After Call Work and Legal Guard states.

Objective Related Procedure and Action

Enable After Call Work.

In the Microsoft-OCS section of the UC Connector Application
object, configure the following:

• presence-acw-note—Enter the note UC
Connector uses when an agent enters the After
Call Work State.

• presence-acw-status—Enter a positive integer
between 1 and 18500.

Enable Legal Guard.

In the Microsoft-OCS section of the UC Connector Application
object, configure the following:

• presence-lg-note—Enter the note UC
Connector uses when an agent exits the After
Call Work state and enters the Legal Guard
state.
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• presence-lg-status—Enter a positive integer
between 1 and 18500.
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Presence Definition Document
You can provide an XML file with presence definitions that can override the default definitions. This
file is recognized as a resource file and its location is defined with the presence-location option.

The default presence definition document is called presence.xml. This file represents the custom
states seen by the agent in releases prior to 8.0.300, which provides backwards compatibility. See
Presence Definition Document Examples for the default presence.xml file and other examples.

Requirements and Restrictions

XML Document
If the namespace of the loaded XML definition is not matched, UC Connector considers the XML
definition to be invalid. If the XML definition is invalid, UC Connector ignores it and continues to use
the previous valid definition.

UC Connector considers an XML document to be valid if at least one state definition is valid.

UC Connector only uses the first root element with the name "presence" for all state definitions.

State ID
The State ID must not contain whitespace characters and it must be unique. If there are multiple
states with the same ID, only the first definition is used.

The following predefined names cannot be used with the state:

• predefLogoutMenu
• predefLoggedOut
• predefOutOfService
• predefReady
• predefPartReady
• predefNotReady
• predefDND

Icons
There are two types of icons used in the web client:
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• Main icons to represent agent status in the agent status indicator on the main panel of the web client.
These icons must be 16 by 16 pixels. The icons can be specified as a local or URL location, or the ID of
a standard icon can be provided. The following table lists predefined icon ID URIs you can use:

Predefined Icon ID URIs
Icon ID URI Icon Description
tag:ucc.genesyslab.com,2013:icons/status/ready Round green shape
tag:ucc.genesyslab.com,2013:icons/status/
partready

Round part green and part orange shape with
vertical divider

tag:ucc.genesyslab.com,2013:icons/status/
notready Round red shape

tag:ucc.genesyslab.com,2013:icons/status/dnd Red "Stop" pictogram
tag:ucc.genesyslab.com,2013:icons/status/logout Red "Out" pictogram
tag:ucc.genesyslab.com,2013:icons/status/oos White cross on grey background

• Badge icons to represent agent status in the agent status indicator Channel view (icons). These icons
must be 10 by 10 pixels. UC Connector will use the location of the main icon to define the location for
the bade icon. For example, if a main icon location is defined as /icons/iconName.png, then UC
Connector will use the location /icons/iconName-badge.png for the badge icon.

UC Connector does not check the supplied images; any image is valid as long as it is supported by
the client browser.

Display Text
The display text entries in the XML definition must follow these guidlines:

• The entry must have an element "stateText" in order to present the status text in agent status
indicators.

• The entry must have an element named "menuText" to make it available for execution. If the element is
missing, UC Connector will not add an entry in the drop-down menu of the web client.

• UC Connector only considers an entry valid if it has either a "menuText" or "stateText" element.
• Entries can be defined for any language, but only languages currently supported by UC Connector will

be used. See List of Supported Languages.
• If an entry for default language is missing, UC Connector does not display the corresponding state in an

unsupported language.

Genesys Agent State Definitions
UC Connector processes the definitions for states in the order in which they are defined in the XML
document. UC Connector uses the first found state that matches an event reported by T-Server to
represent the agent state in the in the agent state indicators. For example, if the XML definition has
an entry defining the state NotReady with no reasons, followed by a definition for the state Not Reay
with reason, then UC Connector uses the first entry.

UC Connector ignores a work mode definition for an element "ready" with a value of "true". If the
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value is "false", UC Connector will accept the following work modes:

• manual
• acw
• legal
• auxwork
• away
• back
• nodisconnect

Important
The work modes might not be supported by T-Server.

Auto State Definition
UC Connector only accepts the following auto-state event definitions:

• preview-reject
• preview-timeout
• preview-redirect

UC Connector checks if the attributes "onevent" and "postevent" refer to an existing state definition.
If no match is found, the value is ignored.

For each of the auto-states missing in the custom-defined XML document, UC Connector uses a
predefined auto-state definition:

• When activated, the default auto-state "preview-reject" invokes the default DND state and the default
Ready state when the timeout defined in the dnd-off-timeout option expires.

• When activated, the default auto-state "preview-timeout" invokes the default NotReady state.
• When activated, the default auto-state "preview-redirect" invokes the default DND state.

Important
UC Connector supports "postevent" only for the auto-state "preview-reject".
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Presence Definition Document Examples
This section provides an example of the presence definition document that allows you to customize
the states available to Knowledge Workers in the UC Connector web client drop-down menu.

<tabber> |-| Custom State Definitions Document=

Example of Custom State Definitions Document

In this example, localization has been inserted into the file to allow for simplicity, but other options
are available as long as the file follows the rules of the Presence Definition XML Schema.

The example below shows a possible customization of the presence.xml file.

<?xml version="1.0" encoding="utf-8"?>
<presence xmlns="http://genesyslab.com/schemas/ucc/presence"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://genesyslab.com/schemas/ucc/presence presence.xsd">

<state icon="ready.png" id="ready">
<display>

<menuText>Set Ready</menuText>
<statusText>Ready for next call</statusText>
</display>
<genesysAgent ready="true"/>

</state>

<state icon="acw.png" id="acw">
<display>

<statusText>Working after call</statusText>
</display>

<display language="fr">
<statusText>Travail apres appel</statusText>
</display>

<display language="de">
<statusText>Arbeiten nach Anruf</statusText>
</display>
<genesysAgent ready="false" mode="acw" />

</state>

<state id="away" icon="away.png">
<display>

<menuText>Set away</menuText>
<statusText>Away from the desk</statusText>
</display>
<genesysAgent ready="false" mode="away" />

</state>

<state id="lunch" icon="away.png">
<display>

<menuText>Lunch</menuText>
<statusText>Away for a lunch</statusText>
</display>
<genesysAgent ready="false" mode="away">
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<reason ext="true">500</reason>
</genesysAgent>

</state>

<state id="auto-away" icon="away.png">
<display>

<statusText>Automatic away</statusText>
</display>
<genesysAgent ready="false" mode="away">

<reason>timeout</reason>
</genesysAgent>

</state>

<state id="busy-preview" icon="busy.png">
<display>

<menuText>On a call</menuText>
<statusText>On a remote call</statusText>
</display>
<genesysAgent ready="false" mode="acw">

<reason>redirect</reason>
</genesysAgent>

</state>

<state id="reject" icon="busy.png">
<display><statusText>Busy after reject</statusText></display>

<genesysAgent ready="false" mode="auxwork">
<reason>reject</reason>

</genesysAgent>
</state>

<auto>
<event name="preview-timeout" onevent="auto-away" />
<event name="preview-reject" onevent="reject" postevent="ready" />
<event name="preview-redirect" onevent="busy-preview"/>

</auto>
</presence>

|-| Presence Definition XML Schema=

Presence Definition XML Schema
<?xml version="1.0" encoding="UTF-8"?>
<schema targetNamespace="http://genesyslab.com/schemas/ucc/presence"
xmlns="http://www.w3.org/2001/XMLSchema"
xmlns:uccp="http://genesyslab.com/schemas/ucc/presence"
elementFormDefault="qualified">
<annotation>
<documentation>Presence states specification in Smart Link solution
</documentation>
</annotation>
<element name="presence">
<annotation>
<documentation>The root element of Smart Link presence containing all
state definitions
</documentation>
</annotation>
<complexType>
<sequence>
<element name="state" type="uccp:StateType" minOccurs="1" maxOccurs="unbounded">
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<annotation>
<documentation>Definition of a distinct state</documentation>
</annotation>
</element>
<element name="auto" type="uccp:AutoStateEvents" minOccurs="0" maxOccurs="1">
<annotation>
<documentation>Automatic state transitions executed by UCC
</documentation>
</annotation>
<key name="event-name">
<selector xpath="event" />
<field xpath="@name" />
</key>
</element>
<element name="composite" minOccurs="0" maxOccurs="unbounded">
<annotation>
<documentation>Definitions of composite multi-channel states.</documentation>
</annotation>
<complexType>
<sequence>
<any>
<annotation>
<documentation>
The schema for complex combined presence states across multiple channels is to
be defined.
Not yet implemented.
</documentation>
</annotation>
</any>
</sequence>
</complexType>
</element>
</sequence>
</complexType>
<key name="state-id">
<selector xpath="state" />
<field xpath="@id" />
</key>
<keyref name="auto-ref" refer="uccp:state-id">
<selector xpath="auto/*" />
<field xpath="@onevent" />
</keyref>
<keyref name="auto-ref-post" refer="uccp:state-id">
<selector xpath="auto/*" />
<field xpath="@postevent" />
</keyref>
</element>
<complexType name="StateText">
<annotation>
<documentation>
Localizable strings for state-related GUI.
</documentation>
</annotation>
<all>
<element name="menuText" type="string" minOccurs="0">
<annotation>
<documentation>
The text that is displayed as GUI menu string.
Absent element means GUI menu is not available (such state can only be
entered automatically and cannot be requested from the menu)
</documentation>
</annotation>
</element>
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<element name="statusText" type="string" minOccurs="0">
<annotation>
<documentation>Text string displayed as current status indicator
when in this state.
Absent element means that the status is not reflected in the status bar.
</documentation>
</annotation>
</element>
</all>
<attribute name="language" type="language" use="optional" />
</complexType>
<complexType name="StateType">
<annotation>
<documentation>Full definition of a state consists of GUI string in one or more
languages,
matching Genesys agent states and UC states.
</documentation>
</annotation>
<sequence>
<element name="display" type="uccp:StateText" minOccurs="1"
maxOccurs="unbounded">
<annotation>
<documentation>GUI appearance of the state</documentation>
</annotation>
</element>
<element name="genesysAgent" type="uccp:GenesysAgentState" minOccurs="1"
maxOccurs="unbounded">
<annotation>
<documentation>Genesys agent state matching this state definition.
UCC user will transition to this state if Genesys agent status
event is received matching this element.
</documentation>
</annotation>
</element>
</sequence>
<attribute name="id" type="ID">
<annotation>
<documentation>Unique ID of the state. It can be used to reference
this state from the "auto" section or "partial" section.
</documentation>
</annotation>
</attribute>
<attribute name="icon" type="anyURI">
<annotation>
<documentation>
Graphic representation of this state in GUI.
Use HTTP URL or one of the pre-defined icon identifiers in the
"tag:ucc.genesyslab.com,2013:icons/status/" namespace
</documentation>
</annotation>
</attribute>
</complexType>
<complexType name="AutoStateEvents">
<sequence>
<element name="event" type="uccp:AutoState" minOccurs="0" maxOccurs="4" />
</sequence>
</complexType>
<complexType name="AutoState">
<annotation>
<documentation>
State transition after event occurrence.
</documentation>
</annotation>
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<attribute name="name" use="required">
<simpleType>
<restriction base="token">
<enumeration value="preview-reject" />
<enumeration value="preview-timeout" />
<enumeration value="preview-redirect" />
</restriction>
</simpleType>
</attribute>
<attribute name="onevent" type="IDREF" use="required">
<annotation>
<documentation>The state that is automatically entered after
the event. It must refer to a defined state id.
</documentation>
</annotation>
</attribute>
<attribute name="postevent" type="IDREF" use="optional">
<annotation>
<documentation>
The state after the timer. Must refer to one of the defined states by its id.
If not specified, the state prior to the event will be restored.
This element is only used if the corresponding duration time is set in CME.
</documentation>
</annotation>
</attribute>
</complexType>
<complexType name="GenesysAgentState">
<annotation>
<documentation>Definition of Genesys agent state</documentation>
</annotation>
<all>
<element name="reason" minOccurs="0" maxOccurs="1">
<annotation>
<documentation>Reason code of the state. Any string.</documentation>
</annotation>
<complexType>
<simpleContent>
<extension base="string">
<attribute name="in">
<annotation>
<documentation>
Whether to match or use the reason in AttributeReasons or
AttributeExtensions.
</documentation>
</annotation>
<simpleType>
<restriction base="token">
<enumeration value="reasons"></enumeration>
<enumeration value="extensions"></enumeration>
</restriction>
</simpleType>
</attribute>
<attribute name="keyname" type="string" default="ReasonCode">
<annotation>
<documentation>
Which data key to use
</documentation>
</annotation>
</attribute>
</extension>
</simpleContent>
</complexType>
</element>
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</all>
<attribute name="ready" type="boolean" use="required">
<annotation>
<documentation>
Whether the definition concerns "ready" or "not ready" agent state.
</documentation>
</annotation>
</attribute>
<attribute name="mode" type="uccp:GenesysAgentMode" default="none">
<annotation>
<documentation>
Agent mode in the event/request. Not all modes may be supported by T-Server.
</documentation>
</annotation>
</attribute>
</complexType>
<simpleType name="GenesysAgentMode">
<restriction base="token">
<enumeration value="none" />
<enumeration value="manual" />
<enumeration value="acw" />
<enumeration value="legal" />
<enumeration value="auxwork" />
<enumeration value="away" />
<enumeration value="back" />
</restriction>
</simpleType>
</schema>
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Deployment Procedures
This section contains detailed procedures related to configuring the Genesys Configuration Database,
the environment, and security. It contains the following topics:

• Genesys Configuration Database Procedures
• Microsoft Procedures
• Security Procedures
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Configuration Database Procedures
This procedures below describe configuring UC Connector in the Genesys Configuration Database.
Although most procedures use Configuration Manager as an example when accessing the
Configuration Database, you can also use Genesys Administrator.

Creating the UC Connector Application Object

Prerequisites

• The host object has been created for the machine where you want to install UC Connector.
• The UC_Connector_800.apd is imported into the Application Templates folder. For details, see Deploying

UC Connector.
• You are logged into Configuration Manager.

1. Go to Environment, right-click the Applications folder, and select New > Application.

2. In the Browse window, select the UC_Connector_800.apd that you created above under
Prerequisites.

3. On the General tab of the new object window, give the UC Connector a Name.

4. On the Server Info tab, browse to select the Host.

5. Lync / Skype for Business requires a secure connection for communication with UC Connector. In
addition to the default listening port, click Add Port to add an additional SIP listening port for
communication with the third-party UC platform.

• Port ID—Enter a useful name for this port.
• Communication Port—Enter the SIP communication port to be used. Any free port on the UC Connector

host may be used.
• Connection Protocol—Select sip from the drop-down list.
• Listening Mode—Select the Secured option.
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6. On the Connections tab, add connections to:

• T-Server/SIP Server—To handle agent and call control.
• Stat Server—To present real time information about resources.
• Message Server—To handle log events.
• Custom Server—To handle the Preview Interaction.

Tip
Custom Server, which links UC Connector to the Universal Routing Server, might not
be created yet. You can add the connection later if required.

7. On the Start Info tab, type a period (.) in the Working Directory, Command Line, and Command
Line Arguments text boxes. The information will be filled in automatically when you install UC
Connector.
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8. Click OK.

Installing the UC Connector Server on the Host

Prerequisites

• A Windows Server 2008/2008 R2/2012/2012 R2 computer on which to install the server.
• A UC Connector Application object is configured.
• JDK 8.0 is installed on the host computer.
• A valid license file placed on a network-accessible location.

1. On the UC Connector 8.0 product CD, locate the setup.exe file and double-click to start the
Genesys Installation Wizard.

Tip
Click the About button to see the read_me file. This file also provides a link to the
product Release Note.

2. Follow the Wizard instructions, clicking Next through each of the following pages:

• Connection Parameters to the Genesys Configuration Server—Enter host name, port, user
name, and password for Configuration Server.

• Select Application—Select the name of the UC Connector Application object.
• Access to License—Select one of the following options:

• License Manager—You want your server application to use host name and port number parameters
to connect to the license server. In this instance, you must enter values for the host and the port of
the license server.

• License File—You want your server application to retrieve license server information from the
license file. Use the Browse button to navigate to the license file.

• Choose Destination Location—UC Connector requires that the path to the installation directory has
no blank spaces. Genesys recommends accepting the default path: C:\GCTI\
UCConnector\[CME_Application_Name]

• Select Installed Java Development Kit (JDK)—Select the JDK version installed for the UC
Connector deployment. This should be the same JDK as the one you previously installed. See Installing
Java in Baseline Components.

• User Parameters—Select HTTP or HTTPS. The installer then asks for the HTTP port. Enter the HTTP port
to be used for HTTP communication between the UC Connector and the web page for the custom UC
Connector tab in the UC client.

Take note of this HTTP port number. You will need to input this later when customizing the Microsoft
Lync / Skype for Business client for integration with UC Connector.
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• For High Availability deployments, use the Windows NLB Virtual IP address for the Host. Do this for both
primary and backup UC Connector instances. You must also use the same port number for both
instances. For details, see About High AvailabilityThrough Windows NLB.

• Unified Communication Server Options—Select your UC platform type: Microsoft-OCS.
• Unified Communication Server Configuration—Enter the following parameters:

UC Platform Parameter Value

Lync / Skype for Business

Contact

Enter the SIP URI configured in Microsoft
Lync/Skype for Business for the UC
Connector. This is the "principal" assigned
to the UC Connector application. For
example, sip:lync-ucc@your-lync-
address.com. This principal represents
the UC Connector in Microsoft Lync/Skype
for Business.

Registrar-uri
Enter the URI that UC Connector uses to
connect to the Microsoft FE Server. For
example, sip:pool01.your-lync-
address.com.

• Ready to Install—Click Install to proceed.

3. In the final Installation Complete page, click Finish.

Configuring UC Connector Options

Prerequisites

• You are logged in to Configuration Manager.
• A UC Connector Application object is configured according to the Creating the UC Connector Application

object tab above.
• Genesys recommends that you create an account/user to represent the UC Connector in Lync / Skype

for Business—for example, lync-ucc.

1. Go to Environment > Applications > and double-click the UC Connector Application object.

2. Go to the Options tab.

3. In the UC-Connector section, configure the following options:

Option Name Default Value Description

chat-title Chat
Enter the name you want to
appear in the regular chat
window.

chat-consult-title Consulting Chat
Enter the name you want to
appear in the window that
appears for consultation chat
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Option Name Default Value Description
interactions.

presence-gateway-mode false

If enabled, UC Connector does
not send invite messages to Lync
/ Skype for Business when there
is no web client UI connected for
the corresponding user, and a
new call or preview call is
delivered. This disables the
Smart Link functionality of the UC
Connector.
If false, sending the invite is controlled by
the invite-message option.

preview-itx-arrival-timeout 9000
UC Connector waits 9 seconds
(9000 ms) after the Preview
Notification is accepted for the
interaction to arrive.

preview-shortkey-accept Blank

If blank, the keyboard hotkey is
disabled. Otherwise, pressing
one of the configured keys
accepts the call
when the interaction Preview window is
displayed.

preview-shortkey-reject Blank

If blank, the keyboard hotkey is
disabled. Otherwise, pressing the
one of the configured keys
rejects the call
when the interaction Preview window is
displayed.

preview-expiration-timeout 15000

UC Connector waits 15 seconds
(15000 ms) for a response from
the target of the Preview
Notification.
If no response, the target user is set to
NotReady. A countdown timer in the
preview window shows how much time is
remaining.

login-queue No default value
Users logging in through the
Custom Tab of the UC client are
logged into the specified ACD
Queue.

dnd-off-timeout 300000

If the user declines the Preview
Notification, UC Connector sets
the user to NotReady

for 300000 milliseconds (5 minutes).

enable-logout-menu false Specifies whether the logout
menu item is displayed in the UC
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Option Name Default Value Description
Connector GUI.

enable-preview-reporting false

Controls whether UC Connector
creates records in ICON for the
interaction Preview events
Accepted, Rejected, Timeout, Taken,
Error, Cancel.

preview-state-name 3721, UCC_Preview

Specifies the numeric identifier
and key name of the custom
state associated with the
UC Connector interaction Preview offer for
the record in ICON.

presence-gateway-mode
UCC_ConnId,UCC_UserId,
UCC_AgentId,UCC_Reason

Specifies the ordered list of key
names used for reporting the UC
Connector Preview offer
parameters in ICON.

userdata-preview-format<n> title: <UserData_DisplayName>,
value: [UserData_Key]

UC Connector displays the value
of the configured UserData_Key
in a field, which will have the
display name as configured in
UserData_DisplayName.

userdata-call-format<n> title: <UserData_DisplayName>,
value: [UserData_Key]

UC Connector displays the value
of the configured UserData_Key
in a field, which will have the
display name as configured in
UserData_DisplayName.

userdata-contact-format title: Contact, value: [USER-ID]

UC Connector displays the value
of the configured USER-ID key
under the field Contact, value:
field.

This value is not displayed in the
interaction, but is required for a valid
configuration.

popup-udata-key Blank

UC Connector shows the call
control window if the option
value is blank. Otherwise, UC
Connector shows the call control
window for calls with the
specified User Data Key.

userdata-note-key KW_ITX_NOTES
UC Connector includes any agent
notes on the interaction in the
Interaction window.

userdata-onringing false

Controls whether the user data
specified in [[user-data-
call_format<n>]] is displayed in
a ringing interaction on the
Knowledge Worker.

userdata-note-onpreview false Controls whether user data
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Option Name Default Value Description
specified in the userdata-note-
key is displayed in a preview
notification on the Knowledge
Worker.

The agent notes for the Preview
window cannot contain single quotation
(') marks.

userdata-note-onringing false

Controls whether user data
specified in userdata-note-key
is displayed in a ringing
interaction on the Knowledge
Worker.

userdata-contact-onpreview false

Controls whether user data
specified in userdata-contact-
format is displayed in a preview
notification on the Knowledge
Worker.

userdata-contact-onringing false

Controls whether the user data
specified in userdata-contact-
format is displayed in a ringing
interaction on the Knowledge
Worker.

userdata-title Case data

Specify the heading name to be
displayed in an interaction for all
the user data specified
by the userdata-call-format<n>
options.

The text configured here appears in
the GUI. If you are localizing the UC
Connector
language, make sure you modify this
option to match the localized language.

userdata-note-title Notes

Specifies the heading name to be
displayed in an interaction for all
the user data specified by
the userdata-note-key option.

The text configured here appears in
the GUI. If you are localizing the UC
Connector
language, make sure you modify this
option to match the localized language.

itx-window-close-timeout 9000

Enter the length of time you want
the interaction to remain open
after the Knowledge Worker
interaction is released or
abandoned.

user-unregister-timeout 300000 (5 minutes)
Enter the length of time, in
milliseconds, that UC Connector
will wait after Knowledge Worker
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Option Name Default Value Description

has closed all browser sessions before it
unregisters the Knowledge Worker DN
with T-Server/SIP Server.

sync-when-logout true

Controls whether UC Connector
logs in a user when only the Lync
presence is available (that is,
there is no independent login
from a Genesys desktop client).
In general, set this option to true
in a back-office environment with
complete Smart Link
functionality. Set it to false when
integrating with Lync Voice in the
contact center.

presence-sync-mode push, pull

Set in the Microsoft-OCS section.
Controls whether, in integration
with Microsoft Lync / Skype for
Business, the presence of a user
is pulled from Microsoft, or
pushed to Microsoft. In case of
pulling the user’s Genesys
presence changes when the
Microsoft one does. In case of
pull, when the status of a user
changes in Genesys this is
reflected in the Microsoft
presence state.

4. In the log section, configure the following UC Connector-specific log option:

• internal—Set this option to the level of message detail you want for the internal UC Connector
components. For other log-related options, see the Framework 8.1 Deployment Guide.

5. If you are integrating with Lync/ Skype for Business, configure the following options in the
Microsoft-OCS section of the UCC Application object.

Option Name Value Description

agent-status-logout 1800, 0-2999, 1800

Maps the Offline presence
status in Lync / Skype for
Business to the Genesys Logout
status.For more details about
these values, see the
Interoperability Values for Lync /
Skype for Business Presence
States in the Additional
Information section.

agent-status-notready 6500,9500,12500,15500,
4500-18000.

Maps the Away presence status in
Lync/Skype for Business to the
Genesys NotReady. For more
details about these values, see
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Option Name Value Description
the Interoperability Values for
Lync / Skype for Business
Presence States in the Additional
Information section.

agent-status-ready 3500, 3000-4499

Maps the Online presence status
in Lync / Skype for Business To
the Genesys Ready status. For
more details about these values,
see the Interoperability Values
for Lync / Skype for Business
Presence States in the Additional
Information section.

contact SIP URI

Enter the user name for the UC
Connector as configured in Lync /
Skype for Business (called the UC
Connector "principal"), For
example, sip:lync-ucc@your-
domain.com.

registrar-uri SIP URI

Enter the URI that UC Connector
uses to connect with Lync / Skype
for Business. For example:
sip:pool01.your-lync-address.com.

6. Click OK.

Interoperability Values for Lync Skype for Business Presence States
The following table shows the interoperability values for the various presence states used in Microsoft
Lync / Skype for Business.

These values correspond to those described in the Microsoft proprietary MS-PRES protocol.
Genesys does not guarantee that these values will remain valid through future product updates. For
the latest values, consult third-party Microsoft documentation.

Interoperability Value Lync / Skype for Business Presence State
0 - 4499 Available
4500 - 5999 Available - Idle
6000 - 7499 Busy
7500 - 8999 Busy - Idle
9000 - 11999 Do Not Disturb
12000 - 14999 Be Right Back
15000 - 17999 Away
>= 18000 Offline

This completes the basic deployment of the UC Connector Application object. Next, create the
Genesys objects used to represent Knowledge Workers in the Genesys environment.
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Creating the Knowledge Worker Place in Genesys Administrator

Prerequisites

• The Knowledge Worker DNs and Agent Logins are created.

1. Under Provisioning > Switching > Places, click the New ... button.

2. After you enter a name for the Place, click the Add ... button.

3. Double-click your Switch.

4. Double-click the DNs folder.

5. Select the DN you created, and click OK.

6. Click Save.

7. Repeat this procedure for every Knowledge Worker that you want to integrate into the contact
center.

Creating the Knowledge Worker Person in Genesys Administrator

Prerequisites

• An Agent Login is created for each Knowledge Worker. You will link to the ID for this Agent Login when
creating the Person.

1. Under Provisioning > Accounts > Users, click the New ... button.

2. Configure the fields on the General tab. For the user name field, the format depends on how
<userid> is configured in the custom tab .xml file. For more information about these fields, click Help
(or consult the Framework 8.1 Deployment Guide).
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3. On the Agent Info tab, browse and select the Place object that you created.

4. Click Add and browse to select the Agent Login that you created.

5. Click the Options tab and select Advanced View (Annex) from the View drop down list.

6. Create a UC-Connector section by using the following option:

• enabled—Set to true to enable this Person object for use with UC Connector.

7. On the Annex tab, depending on which UC platform you are integrating with, configure one of the
following section: Microsoft-OCS.

Then configure the following options (for your UC platform):

Option Name Value Description

agent-status-logout >=1800
Maps the Offline presence
status in Lync / Skype for
Business to the Genesys Logout
status.

agent-status-notready 4500-17999
Maps the Away presence status in
Lync / Skype for Business to the
Genesys NotReady status.

agent-status-ready 0-4499
Maps the Online presence status
in Lync / Skype for Business to
the Genesys Ready status.

contact SIP URI

Enter the Knowledge Worker sign
in name for the UC Connector as
configured in Microsoft Lync /
Skype for Business. For example,
sip:lync-ucc@your-lync-address.com.

8. Click Save.

9. Repeat this procedure for each Knowledge Worker you are integrating into the contact center.

This completes the configuration of the Knowledge Workers as represented in the Genesys
environment. Next, you must integrate the UC Connector with the agent desktop used in your
deployment. For example, you can integrate with Workspace Desktop Edition 8.5.x.

Creating the Custom Server Application object

Prerequisites

• You have the Universal Routing product CD or downloaded IP ready.
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• URS is installed and configured according to the procedures described in the Universal Routing
Deployment Guide.

Important
This procedure provides an overview of the main steps required to install and
configure Custom Server.

1. Import the Custom Server Application template.
Go to the Applications Template folder. Import the Custom_Server_800.apd Application Template
from the Universal Routing CD.

2. Create the Custom Server Application object.
Go to the Applications folder and create a new Custom Server Application object based on the
template you imported.

3. On the General tab, specify the Application name.

4. On the Server info tab, specify the following:

• For non-HA Deployments—Add the same host that is as used by UC Connector.
• For HA deployments—Add the host and port for the Windows NLB virtual IP cluster.

5. Click OK to save.

6. Verify that both UC Connector and URS are both connected to the Custom Server application.

Configuring Contact Points

Purpose: To create the Routing Point DNs exposed in the Knowledge Worker Interaction window for
transfer or conferences to the contact center.

1. Under a configured Switch object, select the DNs folder. In the File menu, select New > DN to
create a new DN object of the type Routing Point.

2. On the Annex tab, create a UC-Connector section with the following options:

Option Description

attribute<n>

Value: format: <display text>: %s, statistic:<object>,
<ObjectType>, <TenantName>, <StatType>, <TimeProfile>,
<StatServerName>

Specifies the statistic to be displayed when the user places their
cursor over the contact point in their Interaction window.
For example, to display the number of calls waiting on a contact
point (Routing Point 1111) as follows:
Calls Waiting: <#of calls>
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configure the value for this option as follows: format: Calls
waiting: %s, statistic:1111@YourSwitch, RoutePoint,
YourTenantName, CurrNumberWaitingCalls, Default

Key Actions:

• All fields are required for UC Connector to
properly subscribe to get the
CurrNumberWaiting statistic from Stat Server.

• You can enter the <n> variable in the option
name as 1, 2, 3, and so on, or leave it empty.

• The parameter <StatServerName> is only
required if UC Connector connects to more than
one Stat Server.

display-name
Value: <required> Enter a unique descriptive name for this
contact point, as you want it to appear in the Interaction
window.

enabled Value: true
Enables the contact to be used by the UC Connector.

3. Click OK.

4. Repeat this procedure (creating a separate Routing Point DN) for each contact point that you want
to appear in the Interaction window.

Contact Point Configuration
Shown below is a sample configured Routing Point DN.

'Next Steps:
1. Create a routing strategy that handles agent selection in the contact center, and load it on this DN.
Interaction Previews for transfers to agents are not required. For general information about designing
routing strategies, see the following Universal Routing documents:

• Universal Routing 8.0 Strategy Samples
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• Universal Routing 8.0 Reference Manual

2. If you are deploying a voice-only UC Connector solution, continue with Configuring the Routing
Strategies.

• Optional. If you want to include Instant Messaging interactions in the deployment, continue with
Enabling Instant Messaging.

• Optional. If you want to enable secure communication in the deployment (and have not already done
so), continue with Enable Secure Communications.

• Mandatory. Secured mode is mandatory for integrations with Microsoft Lync / Skype for Business Server.
For TLS, see Secure Communications in the UC Connector 8.0.3 Lync Integration Deployment Guide.

• For push presence status functionality, Mutual Transport Layer Security (MTLS) is required. See Security
Procedures, Modifying Command Line Arguments for TLS in the UC Connector 8.0.3 Lync Integration
Deployment Guide.

Creating the Custom Server Application object

Prerequisites

• You have the Universal Routing product CD or downloaded IP ready.
• URS is installed and configured according to the procedures described in the Universal Routing

Deployment Guide.

Important
This procedure provides an overview of the main steps required to install and
configure Custom Server.

1. Import the Custom Server Application template.
Go to the Applications Template folder. Import the Custom_Server_800.apd Application Template
from the Universal Routing CD.

2. Create the Custom Server Application object.
Go to the Applications folder and create a new Custom Server Application object based on the
template you imported.

3. On the General tab, specify the Application name.

4. On the Server info tab, specify the following:

• For non-HA Deployments—Add the same host that is as used by UC Connector.
• For HA deployments—Add the host and port for the Windows NLB virtual IP cluster.
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5. Click OK to save.

6. Verify that both UC Connector and URS are both connected to the Custom Server application.
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Microsoft OS Procedures
This section describes Microsft operating system-related procedures.

Modifying the Registry for Microsoft Lync / Skype for Business

Purpose: UC Connector can integrate with the Microsoft Lync / Skype for Business Client through a
"Conversation Extension window" that opens when an interaction arrives at the Knowledge Worker’s
desktop if the UC Connector Web UI is not already running. Additionally, a Custom Menu can be
added to the Microsoft Lync / Skype for Business Client that when selected will start the UC Connector
Web UI. Both features require an import to the Windows Registry using a registry file included in the
UC Connection installation.

Important
Use of the "conversation extension window" currently only supported on Lync
deployments. It is not supported when using Skype for Business. Custom Menus are
supported on both Lync and Skype for Business deployments.

1. On the UC Connector host machine, locate the registry file required for your operating system. Go
to the microsoft-oc-client folder in the UC Connector installation, and select one of the following
registry files:

• mocAppLync—For Lync / Skype for Business on 32-bit systems.
• mocAppLync64—For Lync Lync / Skype for Business on 64-bit system.

2. Double click on the relevant file for the Registry entries to be updated.

3. Alternatively, on the Knowledge Worker machine (where the Lync / Skype for Business client is
installed), open the Windows Registry Editor. Click Start > Run > Regedit and navigate to the path
that you found in Step 1.

4. Repeat this process for every Knowledge Worker client machine in your deployment.

Next Steps:

1. Set user-auto-registration to true. This enables automated login for all Knowledge Workers.

2. Secured mode is mandatory for integrations with Microsoft Lync.

• For TLS, see Enabling Secure Communication.
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• For push presence status functionality with Lync, Mutual Transport Layer Security (MTLS) is required.

See Enabling Secure Communication. 3. Once secured mode is configured, you must integrate the UC
Connector deployment with Genesys Routing. See Integrating with Genesys Routing.

Adding Authorized Hosts to Microsoft

This procedure involves adding UCC hosts as an Authorized Host in the installation. If the UCC host
should not be authorized, you may want to enable Kerberos security instead. For details, see the UC
Connector 8.0.3 Integration Deployment Guide, Trusted Host.

Deployment Procedures Microsoft OS Procedures

UC Connector Deployment Guide 119

https://docs.genesys.com/Documentation/UCC/latest/Integration/TrustedHost


Security Procedures
For procedures, see the UC Connector 8.0.3 Lync Integration Deployment Guide, Security Procedures.
That guide contain the following procedures, which apply to both Lync and Smart Link:

• Adding UCC Host as Trusted Host in Lync
• Generating the Client Certificate
• Generating the Server Certificate Using Skype for Business Management Shell
• Generating_the Server Certificate Using Microsoft Management Console
• Generating the Server Certificate using Microsoft Management Console or CA Web Access
• Generating the Front End Server Certificate
• Modifying Command Line Arguments for MTLS
• Enabling Kerberos Security Between UCC and Lync Skype for Business
• Configuring Kerberos Security in Active Directory
• Creating a Password for Kerberos Security
• Exporting the Trusted Certificate from the Lync Skype for Business Host
• Adding the Certificate to the UC Connector Installation
• Creating the Configuration File for Kerberos Security
• Configuring a Secure SIP Port
• Modifying Command Line Parameters for TLS
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Configuring the Routing Strategies
This section describes a few sample Universal Routing Server (URS) routing strategies, as configured
in Interaction Routing Designer (IRD), which can be used to deliver interactions from an agent to the
Knowledge Worker— including negotiation of the PreviewInteraction protocol for delivering the
Preview Notification.

Important
This section does not provide detailed step-by-step instructions for designing routing
strategies, but instead gives samples and key information that you can work from. If
you need detailed information about using IRD, see the Universal Routing 8.1
Deployment Guide.

This section contains the following topics:

• About the Key Routing Blocks
• About the Preview Interaction Protocol
• Routing to a Particular Knowledge Worker
• Routing with Robin-Robin Selection
• Routing with Broadcast Preview

Important
Although Genesys now offers other and more advanced routing configuration tools,
IRD is still required to configure the UC Connector, since it's the only tool capable of
setting up the Custom Server included into the UC Connector.
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About the Key Routing Blocks
The following table gives an overview of the main blocks that are used in the configuration of the
sample routing strategies described in this section. For additional information on these blocks, see
the Interaction Routing Designer Help.

Routing Block Key Action

Attach data block

Used for adding UserData for the call, which will include any
key-value pairs (KVPs) sent by the agent.
For example, a KVP that:

• Adds agent Notes on the interaction.
• Specifies a particular KW to target for this call.

Limitation: For agent notes that will appear in the Preview
window, the text cannot contain a single (') mark. Universal
Routing Server (URS) does not process this quotation mark as
regular text.

SelectDN block
Used for building the expression that will choose the DN.

• Point to the Stat Server instance installed in
your environment.

BlockDN
Used for environments with multiple URS instances. BlockDN
makes the Target DN selected by this strategy unavailable for
the duration specified in this block, so that other URS instances
do not attempt to route interactions to this DN.

Database blocks

These are the key blocks for the Preview Interaction.
When configuring this block, you will:

• Connect the strategy to the Custom Server
module built into the UC Connector.

• Specify the PreviewInteraction protocol
message to be sent to the Custom Server. For
example, PreviewInterationRequest, which
asks Custom Server to initiate the preview.

• Specify how to process the results that come
back from the Custom Server.

Sample Screenshots
For some sample screenshots of the Database Wizard, see
PreviewInteractionRequest Database Block.
About The Protocol Formats
For a list of formats to be used with the various
PreviewInteraction protocol messages, see About the Preview
Interaction Protocol.
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PreviewInteractionRequest Database Block

The following figures show sample configuration screens from the database wizard for the
PreviewInteractionRequest Database Block.

1. Select Customer Server
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2. Configure the PreviewInteractionRequest Message
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3. Assigning Values to the Results from Custom Server

4. Mapping KVPs to Variables
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About the Preview Interaction Protocol
The following table shows the various PreviewInteraction protocol messages and the formats that
go along with them.

Message Format

PreviewInteractionRequest

Initiates the Preview Interaction with the targeted Knowledge
Worker.

agent
connId
dn
mediaType
switch
userData

PreviewInteractionCancel

Indicates to the Knowledge Worker that the interaction is
canceled.

Contact
ThisDN
ConnID
OtherDN
MediaType
UserData
Message
Status
StatusMessage

PreviewInteractionMultiple

Initiates the Preview Interaction with the Knowledge Worker
group. This acts like a broadcast to all the agents in the group.

connId—Used as a key for this interaction, and added to any ICO
reporting messages.
mediaType—Media type as assigned by T-Server/SIP Server.
userData—Used for display, this may include the filter third-
party window key.
targets—A list of agents found from a source (for example, Stat
Server). The default delimiter "|" should be replaced with "^".
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Routing to a Particular Knowledge Worker
The following shows a sample strategy that routes a call to a particular Knowledge Worker selected
by the agent.
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For details about the call flow that this strategy supports, see Contact Center to Knowledge Worker.
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Routing with Round-Robin Selection
The following shows a sample strategy that routes a call to an available Knowledge Worker using a
round-robin selection method.
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For details about the call flow that this strategy supports, see Contact Center to Knowledge Worker.
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Routing with Broadcast Preview
The following shows a sample strategy that broadcasts preview notifications simultaneous to a set of
Knowledge Workers.
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UC Connector High Availability Deployment
This section describes the steps required to deploy primary and backup UC Connector instances in a
High Availability (HA) configuration, using a virtual IP-based architecture provided by Windows
Network Load Balancer (NLB).

Note: The information in the sections below present a Network Load Balancer (NLB) cluster approach
rather than the recommended IP Address Takeover Approach.

This section contains the following topics:

• About HA Through Windows NLB
• How the Switchover Works
• Deploying HA Instances of UC Connector

For HA architecture diagrams, see High Availability in UCC Connector Overview and Architecture.
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About HA Through Windows NLB
Note: The information below presents an NLB cluster approach rather than the recommended IP
Address Takeover Approach.

Windows Network Load Balancer (NLB) is used to provide high-availability for the following
connections:

• The interaction web page on the Knowledge Worker desktop—the custom UC Connector tab—and the
UC Connector web port.

• Universal Routing Server (URS) and the UC Connector Custom Server port.

The ports used for both of these connections must be switched over as part of the Window NLB
mechanism, in order to ensure that both the Preview Notification method and the custom UC
Connector tab continue to operate after a switchover from primary to backup instance of UC
Connector.

When configured for HA, the HTTP messages from the UC platform are sent to the Windows NLB
cluster—using the virtual IP (VIP) address—and the Windows NLB cluster then delivers this traffic to
the individual UC Connector instance, according to its unique IP address.

This figure shows an overview of how HA-enabled UC Connector instances can be deployed. While
web communication with the UC platform uses a single Virtual IP address to communicate with UC
Connector, Genesys Management and Configuration Layer components and T-Library clients use the
unique IP address for communication with the UC Connector and the Local Control Agent (LCA)
installed at each UC Connector host.

When a failure occurs, Genesys performs a switchover of the failed primary UC Connector instance to
the backup instance. The Genesys Management Layer uses a Windows NLB utility (wlbs.exe or
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nlb.exe) to enable and disable the web ports used by UC Connector. To start this utility, special
control scripts (.bat files) are required. These scripts are triggered when alarm conditions in the UC
Connector log events are generated as the UC Connector instances switch modes from primary to
backup.
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How The Switchover Works
Genesys recommends an IP Address Takeover approach rather than using an NLB cluster
configuration approach as in previous UCC releases. For a primary UC Connector application failure
workflow, see the Framework 8.1 SIP Server High-Availability Deployment Guide, Deploying IP
Address Takeover.

Note: The information below presents an NLB cluster approach rather than the recommended IP
Address Takeover Approach.

The following steps describe a primary UC Connector failure workflow for a Windows NLB cluster
configuration.

1. The primary UC Connector (UC Connector 1) fails.

2. The LCA detects the primary UC Connector application failure and reports it to the SCS.

3. Through the LCA, SCS instructs the backup UC Connector (UC Connector 2) to go into primary mode.

4. When backup UC Connector (UC Connector 2) goes into primary mode, a log event occurs, which
indicates that the backup UC Connector has changed to primary mode. The log event triggers an
associated alarm condition.

5. The alarm condition triggers associated alarm reaction scripts.

6. The alarm reaction scripts trigger the associated VIP control script application objects.

7. The control scripts run Windows NLB utilities that disable the Web and Custom Server ports on the
primary UC Connector and enable the web port on the backup UC Connector.
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Deploying HA Instances of UC Connector
The following table provides an overview of the tasks you must complete to deploy a highly available
configuration of UC Connector in a Windows NLB cluster environment.

Note: The information below presents an NLB cluster approach rather than the recommended IP
Address Takeover Approach.

Step Related procedures and Information
Ensure that your system meets the deployment
prerequisites.

See Windows NLB Cluster HA Deployment
Prerequisites.

Configure Windows Network Load Balancing (NLB)
Parameters.

Use the Windows NLB Configuration Manager to
configure load balancing parameters, as described
in Configuring Windows NLB cluster parameters.

UC Connector HA Deployment.

Complete the following procedures to deploy your UC Connector
HA configuration:
1. Configuring the primary UC Connector (Windows NLB cluster).
2. Configuring the Backup UC Connector (Windows NLB cluster).
3. Configuring HA for Custom Server.
4. Creating Virtual IP Interface control scripts (Windows NLB
cluster). Virtual IP (VIP) interface control scripts are used to
enable and disable UC Connector ports when UC Connector
change modes.
5. Creating application objects for VIP control scripts (Windows
NLB cluster). Application objects allow the VIP control scripts to
be run as applications.
6. Creating alarm reaction scripts (Windows NLB cluster). Alarm
reaction scripts are called when HA-related alarm conditions are
activated.
7. Creating alarm conditions (Windows NLB cluster). When an
HA-related log event occurs, such as a log event that records
when a UC Connector changes from primary to backup mode,
Alarm Conditions are activated.
8. Testing alarm conditions (Windows NLB cluster).
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UC Connector HA Deployment Procedures
Note: The information below presents an NLB cluster approach rather than the recommended IP
Address Takeover Approach.

Windows NLB Cluster HA Deployment Prerequisite

Windows NLB Cluster HA Deployment Prerequisites

• Two separate physical host computers, one for the primary UC Connector and one for the backup UC
Connector.

• Software requirements:
• UC Connector must be installed and configured on both host computers.
• A Local Control Agent (LCA) must be installed and configured on both host computers.
• A Message Server must be installed.

• Networking requirements:
• A name resolution method such as Domain Name System (DNS), DNS dynamic update protocol, or

Windows Internet Name Service (WINS) is required.
• Both host computers must be members of the same domain.
• A domain-level account that is a member of the local Administrators group is required on each host

computer. A dedicated account is recommended.
• Each host computer must have a unique NetBIOS name.

• A static IP address is required for each of the network interfaces on both host computers. Server
clustering does not support IP addresses assigned through DHCP.

• A dedicated network switch or separate VLAN for cluster adapters is recommended to reduce switch
flooding that may be caused by Windows Network Load Balancing.

• Access to a domain controller is required. If the cluster service is unable to authenticate the user
account used to start the service, the cluster may fail. It is recommended that the domain controller
be on the same Local Area Network (LAN) as the cluster to ensure availability.

• Each node must have at least two network adapters; one for the connection to the public network
and the other for the node-to-node private cluster network.

• A dedicated private network adapter is required for HCL certification.
• All nodes must have two physically independent LANs or Virtual LANs for public and private

communication.
• If you are using fault-tolerant network cards or network adapter teaming, verify that firmware and

drivers are up to date and check with your network adapter manufacturer for Windows NLB cluster
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compatibility.

Configuring Windows NLB cluster parameters

Configuring Windows NLB cluster parameters

Purpose: To configure Windows Network Load Balancing (NLB) parameters required for a UC
Connector HA deployment.

1. Open the Microsoft Network Load Balancing Manager tool.

2. Select a cluster host and open the Cluster Properties window.

3. On the Cluster Parameters tab, select the Cluster operation mode. You can choose Unicast
(default) or Multicast mode. For information about Windows NLB Unicast and Multicast modes, refer
to your Microsoft Windows Server documentation.

4. Click the Port Rules tab.

• Specify a Port range that includes the port that you will assign as the web port.
• In the Protocols section, select Both (for both UDP and TCP).
• In the Filtering mode section, select Multiple host and set Affinity to None or Single.
• Set Load weight to Equal.

5. Click the Host Parameters tab. In the Initial host state section, set the Default state to
Stopped.

For more information about Windows NLB cluster parameters, refer to your Microsoft Windows Server
documentation.

Configuring the primary UC Connector (Windows NLB cluster)

Configuring the primary UC Connector (Windows NLB cluster)

Purpose: To configure the primary UC Connector Application object for high availability.

1. Stop the UC Connector service on the primary and backup hosts. Genesys UC Connector services
can be stopped using the Windows Services dialog box.

2. Change the HTTP host to the virtual IP address for the Windows NLB cluster. In the UC Connector
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Application object, go to the Start Info tab and modify the Command Line Arguments as follows:
-ucc_host <Virtual_IP_address_of_NLB_cluster>

3. Make sure that the HTTP port is one that can be shared on both primary and backup UC Connector
hosts. To check the primary HTTP port, go to the Command Line Arguments and take note of the port
number specified by the following parameter:
-http_port <shared_port_number>

Important
Modifying the Command Line Arguments is suggested for enabling
HA on existing UC Connector instances only. If you are deploying new instances of UC
Connector for HA, you can specify these Host and Port parameters in the User
Parameters page of the Installation wizard. The same rules apply:

• Set ucc_host for both primary and backup to the same virtual IP address of the
Windows NLB cluster.

• Set http_port for both primary and backup to the same value.

4. Open Configuration Manager.

5. Select the Applications folder and right click the UC Connector Application object that you want
to configure as the primary UC Connector. Select Properties.

6. Click the Options tab, Log section.

• Set the standard option to network.
• Set the verbose option to all.

Important
Setting logging options is required for this UC Connector HA
configuration. HA-related log events pass through the Message Server to activate
alarm conditions and reaction scripts necessary for managing failover between the
primary and backup instances of

UC Connector.

• Click Apply to save the configuration changes.
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7. Click the Server Info tab.

• Set the Redundancy Type to Warm Standby.
• For the Backup Server option, select the UC Connector Application object you want to use as the

backup UC Connector. If necessary, browse to locate the backup UC Connector Application object.
• Click Apply to save the configuration changes.

8. Click the Start Info tab.

• Select Auto-Restart.
• Click Apply to save the configuration changes.

9. Click the Connections tab, and then click Add to create a connection to the Message Server.

10. Click Apply and OK to save the configuration changes.

Configuring the Backup UC Connector (Windows NLB cluster)

Configuring the Backup UC Connector (Windows NLB cluster)

Purpose: To configure the backup UC Connector Application object for high availability.

1. Stop both primary and backup UC Connectors if they are running. You can stop the UC Connector
service using the Windows Services dialog.

2. Change the HTTP host to the virtual IP address for the Windows NLB cluster. In the UC Connector
Application object, go to the Start Info tab and modify the Command Line Arguments as follows:
-ucc_host to ucc_host <Virtual_IP_address_of_NLB_cluster>

3. Assign the same HTTP port as used in the primary UC Connector host. Go to the Command Line
Arguments and enter the shared port number in the following parameter:
-ucc_port <shared_port_number>

Important
Modifying the Command Line Arguments is suggested for enabling
HA on existing UC Connector instances only. If you are deploying new
UC Connectors for HA, you can specify these Host and Port
parameters in the User Parameters page of the Installation wizard.
The same rules apply:
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• Set ucc_host for both primary and backup to the same virtual IP address of the NLB
cluster.

• Set http_port for both primary and backup to the same value.

4. Open Configuration Manager.

5. Select the Applications folder and right click on the UC Connector application object that you
want to configure as the backup UC Connector.

6. Click the Start Info tab.

• Select Auto-Restart.
• Click Apply to save the configuration changes.

7. Click the Options tab, Log section.

• Set the standard option to network.
• Set the verbose option to all.

Important
Setting Log options is required for this UC Connector HA
configuration. HA related log events pass through the Message
Server to activate alarm conditions and reaction scripts necessary
for managing failover between the primary and backup UC
Connectors.

• Click Apply to save the configuration changes.

8. Click Apply and OK to save the configuration changes.

Configuring HA for Custom Server
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Configuring HA for Custom Server

Purpose: To complete the configuration steps required to support integration of Custom Server with
the Windows NLB virtual IP address.

Custom Server does not need to be deployed in an HA pair. However, the Custom Server application
must be configured on a host created for the virtual IP address.

1. In Configuration Manager, create a new Host object, specifying the IP address that you configured
as the virtual IP for the NLB cluster.

2. Create a new Custom Server Application object, specifying this virtual IP-based Genesys host. For
details about creating this object, see Creating the Custom Server Application object.

Creating Virtual IP Interface control scripts (Windows NLB cluster)

Creating Virtual IP Interface control scripts (Windows NLB cluster)

Purpose: To create Virtual IP (VIP) control scripts for each of the UC Connectors. Each UC Connector
host requires VIP control scripts to enable or disable the Virtual IP (VIP) interface on the host
computer when the role of the UC Connector changes. The scripts are used to enabled the VIP
interface on the host where the UC Connector is in primary mode and disabled the VIP interface on
the host where the UC Connector is in backup mode.

In this procedure, you will create the following four VIP Control Scripts:

• uc_connector_prime_up.bat: Enables the VIP interface on the primary host.
• uc_connector_prime_down.bat: Disables the VIP interface on the primary host
• uc_connector_backup_up.bat: Enables the VIP interface on the backup host
• uc_connector_backup_down.bat: Disables the VIP interface on the backup host

Important
You can use the script names listed above or you can specify your
own script names. If you get security-related error messages for
these scripts, you may need to add a password parameter to the
wlbs.exe commands. For example, add /PASSW <your_password>
to the command: wlbs.exe enable 5060 123.45.68.90:2 /PASSW
yourpass123

1. On the primary UC Connector host, create a batch file named uc_connector_prime_up.bat and
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input the following commands:

@title Enable Virtual IP Control Script
@echo ************** Primary VIP Enabled ************** >> vip1.log
@echo %time% >> vip1.log
wlbs.exe start uccluster:1 >> vip1.log
wlbs.exe enable <your_web_port> uccluster:1 >> vip1.log
wlbs.exe enable <your_Custom_Server_port> uccluster:1 >> vip1.log
wlbs.exe disable <your_web_port> uccluster:2 >> vip1.log
wlbs.exe enable <your_Custom_Server_port> uccluster:2 >> vip1.log
exit

2. On the primary UC Connector host, create a batch file named uc_connector_prime_down.bat and
input the following commands:

@title Disable Virtual IP Control Script
@echo *************** Primary VIP Disabled ************ >> vip1.log
@echo %time% >> vip1.log
wlbs.exe disable <your_web_port> uccluster:1 >> vip1.log
wlbs.exe disable <your_Custom_Server_port> uccluster:1 >> vip1.log
ping –n 2 127.0.0.1
exit

3. On the backup UC Connector host, create a batch file named uc_connector_backup_up.bat and
input the following commands:

@title Enable Virtual IP Control Script
@echo ************** Backup VIP Enabled *************** >> vip2.log
@echo %time% >> vip2.log
wlbs.exe start uccluster:2 >> vip2.log
wlbs.exe enable <your_web_port> uccluster:2 >> vip2.log
wlbs.exe enable <your_Custum_Server_port> uccluster:2 >> vip2.log
wlbs.exe disable <your_web_port> uccluster:1 >> vip2.log
wlbs.exe disable <your_Customer_Server_port> uccluster:1 >> vip2.log
exit

4. On the backup UC Connector host, create a batch file named uc_connector_backup_down.bat and
input the following commands:

@title Disable Virtual IP Control Script
@echo ***************** Backup VIP Disabled *********** >> vip2.log
@echo %time% >> vip2.log
wlbs.exe disable <your_web_port> uccluster:2 >> vip2.log
wlbs.exe disable <your_Custom_Server_port> uccluster:2 >> vip2.log
ping –n 2 127.0.0.1
exit

Important
The scripts above include commands to log script execution. The
logs are created in the directory where the script is located.

Creating application objects for VIP control scripts (Windows NLB
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cluster)

Creating application objects for VIP control scripts (Windows NLB
cluster)

Purpose: To create the four “Third Party Server” application objects listed below; one for each of the
VIP control scripts created in Creating Virtual IP Interface control scripts (Windows NLB cluster).

• uc_connector_Prime_Up
• uc_connector_Prime_Down
• uc_connector_Backup_Up
• uc_connector_Backup_Down

Creating application objects for the VIP control scripts allows the scripts to be run as applications
within the Genesys framework.

Prerequisites
The Third Party Server template must already exist in the Application Templates folder. If not,
right-click this folder, select Import Application Template, and import the Third Party Server
template from your Management Framework CD.

1. In Configuration Manager, select Environment > Applications.

2. Right click and select New > Application.

3. Select the Third Party Server template from the Application Templates folder and click OK.

4. On the General tab, enter a name for the application object.

Important
You can use the application object names listed above or you can
specify your own.

5. Select the Server Info tab.

• Select the host name of the UC Connector where the corresponding VIP control script is located.
• If necessary, specify a valid communication port number using the Edit Port option.
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Important
This port will not be used. However, because of the way the
application works, the port may have to be specified in order to save
the application.

6. Select the Start Info tab.

• Set the Working Directory to the location of the control script and enter name of the script in the
Command Line field.

• If you are configuring an application object that disables a VIP interface (uc_connector_Prime_Down
and uc_connector_Backup_Down), set the Timeout Startup value to 8.

7. Repeat the steps in this procedure to create application objects for each of the four VIP control
scripts.

Creating alarm reaction scripts (Windows NLB cluster)

Creating alarm reaction scripts (Windows NLB cluster)

Purpose: To create alarm reaction scripts for HA-related alarm conditions. When an HA-related alarm
condition occurs, the associated alarm reaction script is run. Alarm reaction scripts are configured to
call the application objects you created in Creating application objects for VIP control scripts
(Windows NLB cluster).

1. Open Configuration Manager.

2. Select Resources > Scripts.

3. Right click and select New > Script.
4. Create four scripts, one for each of the applications objects you created earlier. Select Alarm
Reaction as the Script Type. For example, create the following four Alarm Reaction scripts:

• AR_Script_Prime_Up
• AR_Script_Prime_Down
• AR_Script_Backup_Up
• AR_Script_Backup_Down

5. For each of the Alarm Reaction scripts, use the Alarm Reaction Wizard to configure the Alarm
Reaction Type.
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• Select an Alarm Reaction script and right-click to open the Alarm Reaction Wizard (select Wizard >
Configure).

• In the Alarm Reaction Wizard, click Next.
• In the Alarm Reaction Type dialog, select Start a specified application and click Next.
• Browse to select the corresponding application object. For example, for the AR_Script_Prime_Up Alarm

Reaction script, select the uc_connector_Prime_Up Third Party Server application object.
• Repeat the previous steps to configure each of the Alarm Reaction scripts you created.

Creating alarm conditions (Windows NLB cluster)

Creating alarm conditions (Windows NLB cluster)

Purpose: Alarm Conditions are required to handle log events that occur when a UC Connector
changes its mode from primary to backup or backup to primary. When you create the Alarm
Conditions, you configure them to trigger the alarm reaction scripts you created in Creating alarm
reaction scripts (Windows NLB cluster).

Four alarm conditions are required for your HA configuration, two for the primary UC Connector
application and two for the backup. Refer to the procedure that follows to create the alarm conditions
required for your configuration.

Alarm Conditions for Warm Standby
Name Log Event ID Application Reaction Script

ALRM_Primary_down_4560 4560 <Primary UC
Connector> AR_Script_Prime_Down

ALRM_Primary_up_4562 4562 <Primary UC
Connector> AR_Script_Prime_Up

ALRM_Backup_down_4560 4560 <Backup UC
Connector> AR_Script_Backup_Down

ALRM_Backup_up_4562 4562 <Backup UC
Connector> AR_Script_Backup_Up

1. Open Configuration Manager.

2. Navigate to the Environment > Alarm Conditions folder.

3. Right click and select New > Alarm Condition to open the New Alarm Condition Properties
dialog.

4. On the General tab:

• Enter a Name for the Alarm Condition.
• Optionally, enter a description.
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• For the Category value, select Critical.
• Set Cancel Timeout to 3.

5. On the Detect Event tab:

• Set the Log Event ID.
• Set the Selection Mode to Select By Application.
• For the Application Name field, click the folder icon to browse for the UC Connector Application object.

If you are creating an Alarm Condition for the primary UC Connector, select the primary UC Connector
application object. If you are creating an Alarm Condition for the backup UC Connector, select the
backup UC Connector application object.

6. Click OK.

7. On the Reaction Scripts tab, add the alarm reaction script as defined according to the table at
the beginning of this procedure.

8. Repeat the steps in this procedure to create each of the four Alarm Conditions for your hot or warm
standby configuration.

Testing alarm conditions (Windows NLB cluster)

Testing alarm conditions (Windows NLB cluster)

Purpose: To verify that the alarm conditions work as expected.

1. Open the Solution Control Interface (SCI).

2. Under Alarm Conditions, select the ALRM_Primary_4561 Alarm Condition, right click, and click
Test. The ALRM_Primary_4561 Alarm Condition indicates that the primary UC Connector is in backup
mode which triggers the alarm reaction scripts that disable the Virtual IP interface at the primary UC
Connector and disable the VIP interface at the backup UC Connector.

3. Use an wlbs queryport <your_web_port> or <your_Custom_Server_port> command to verify
that the Virtual IP interface is active on the backup UC Connector and that the Virtual IP interface is
inactive on the primary UC Connector.
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Configuration Options
This section describes the configuration options that are modified during the procedures included in
this guide. Options are organized according to component type, and include the following:

• UC Connector Application Options
• Other Options
• Switch/DN Level Options
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UCC Application Options
Configure these options in Genesys Administrator or Configuration Manager.

UC-Connector Section

Configure these options in the UC-Connector section of the UCC Application object.

audio-on-preview

Default Value: No default value
Valid Values: URL or file name
Changes Take Effect: Immediately
Specifies the location of the audio file that will be played when the Preview pop-up window is
displayed.

audio-on-ring

Default Value: No default value
Valid Values: URL or file name
Changes Take Effect: Immediately
Specifies the location of the audio file that will be played when the Ringing pop-up window is
displayed.

Important
The audio-on-ring and audio-on-preview options are only applicable when UC
Connector is used in non-gateway mode (presence-gateway-mode is set to false).

chat-title

Default Value: Chat
Valid Values: Any string
Changes Take Effect: Immediately
Specifies the name used for the Chat window. By default, the window uses the name Chat. You can
use any other name for this section by changing the value of this option.

chat-consult-title

Default Value: Consulting Chat
Valid Values: Any string
Changes Take Effect: Immediately
Specifies the name used for the Chat window that opens for consultation chat interactions. By
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default, the window uses the name Consulting Chat. You can use any other name for this section by
changing the value of this option.

dnd-off-timeout

Default Value: 300000
Valid Values: Any positive integer
Changes Take Effect: Immediately
Specifies the duration, in milliseconds, that UC Connector will set an agent to Do-Not-Disturb (DND) if
the Knowledge Worker rejects the Preview Notification.

Important
If UC Connector receives an agent state change event from SIP Server/T-Server
(EventAgentReady, EventAgentNotReady, or EventAgentLogout) while the timer is
active, then the timer will be cancelled.

enable-logout-menu

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether the log out menu item is displayed in the UC Connector GUI for the particular user,
if no UC system configuration annexes are present in the Person configuration in CME.

enable-preview-reporting

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Related Feature: How It Works Reporting Events
When set to true, UC Connector creates records in ICON for the interaction Preview events accept,
reject, timeout, or withdrawn due to another user in the group accepting the interaction.

Warning
Enabling this option will cause extra network traffic from UC Connector to T-Server/SIP
Server, so you should check your network limits.

gla-call-match-window

Default Value: 4000
Valid Values: 20001500
Changes Take Effect: Immediately
Specifies the time window, in milliseconds, in which a T-Lib call is matched against a Lync call
reported by GLA. Lync and T-Lib call events do not have a common reference and can only be
matched by co-incidence in time.
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gla-kpl-time

Default Value: 30
Valid Values: 4Integer greater than the value of gla-kpl-response-time
Changes Take Effect: Immediately
Specifies the interval, in seconds, between GLA keep alive messages being sent to UC Connector.

gla-kpl-response-time

Default Value: 4
Valid Values: 3Integer less than the value of gla-kpl-time
Changes Take Effect: Immediately
Specifies the expected time, in seconds, for UC Connector to respond to the keep alive messages
sent by GLA. |

help-callcontrol-url

• Default Value: No default value
• Valid Values: a valid path to an .html file
• Changes Take Effect: Immediately
• Specifies the URL path to the .html help file that appears when the user clicks the Help button on the

Call Control or Preview windows. For example, if you copy the sample Call Control Help file from the CD
to the UC Connector installation folder, enter a path something like the following:

help/callcontrol.html

If you do not configure this option, the Help button does not appear.

If you are hosting your help file externally, use a fully qualified URL as the value for this option. For
example:

http://www.companyhelp.com

help-interaction-url

Default Value: No default value Valid Values: a valid path to an .html file
Changes Take Effect: Immediately
Specifies the URL path to the .html help file that appears when the user clicks the Help button on
the Interaction window. For example, if you copy the sample Help file from the CD to the UC
Connector installation folder, enter a path something like the following:

help/interaction.html

If you do not configure this option, the Help button does not appear.

If you are hosting your help file externally, use a fully qualified URL as the value for this option. For
example:

http://www.companyhelp.com
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help-login-url

Default Value: No default value
Valid Values: a valid path to an .html file
Changes Take Effect: Immediately
Specifies the URL path to the .html help file that appears when the user clicks the Help button on the
Login screen. For example, if you copy the sample Call Control Help file from the CD to the UC
Connector installation folder, enter a path something like the following:

help/login.html

If you do not configure this option, the Help button does not appear.

If you are hosting your help file externally, use a fully qualified URL as the value for this option. For
example:

http://www.companyhelp.com

itx-window-close-timeout

Default Value: 9000
Valid Values: Any positive integer
Changes Take Effect: Immediately
Specifies the length of time you want the interaction to remain open after the Knowledge Worker
interaction is released or abandoned.

locale

Default Value: en
Valid Values: A two-character country code
Changes Take Effect: Immediately
Related Feature: How It Works Customized Languages
Specifies the default language to be used in the UC Connector user interface, if not otherwise
specified by the integrated web browser. By default, UC Connector uses English (en) for all the labels
and buttons in the user interface. To set UC Connector to a different default language, enter one of
the supported two-character country codes listed in Supported Languages. If you set this option to
default, then the language of the local operating system where the UC Connector is running will be
used. If you do not configure this option at all, then English is used as the absolute default language.

login-queue

Default Value: Blank
Valid Values: A valid DN
Changes Take Effect: Immediately
Specifies the value used to populate the agent login request parameter queue. SIP Server can use
this value for default routing in case of URS failure. The effects of this parameter depend on the T-
Server and other solution components. See the deployment guide for your T-Server/SIP Server for
information on whether it supports this feature.

popup-udata-key

Default Value: Blank
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Valid Values: A string representing a User Data Key
Changes Take Effect: Immediately
If the value is blank, UC Connector will display the third-party call control window to the user for all
arriving calls. If the option value contains a User Data Key, UC Connector will only display the call
control window for calls with the specified User Data Key present in the User Data of the call.

Important
Calls delivered using the Preview window will not be suppressed, regardless of user
data filer. Clicking on transaction line in the main UC Connector window will bring up
the third-party call control window regardless of user data filter.

presence-gateway-mode

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector prevents sending invite messages to Lync when there is no web
client UI connected for the corresponding user, and a new call or preview call is delivered. If true, UC
Connector does not send SIP "INVITE" to Lync; otherwise, sending the invite is controlled by the
invite-message option.

presence-location

Default Value: blank
Valid Values: string format, URL or file location
Changes Take Effect: Immediately
Specifies the location of the XML presence configuration file.

Important
• The configuration file is only reloaded when the option changes.
• The default definitions will be used if the option is empty.
• If the XML is not valid, the current definition in use will remain in effect.
• If the resource directory location is specified, then all the files the presence.xml file

requires must be in the same directory.

preview-info-keys

Default Value: UCC_ConnId,UCC_UserId,UCC_AgentId,UCC_Reason
Valid Values: A comma-separated list of four identifiers:
<keyname>,<keyname>,<keyname>,<keyname>
Changes Take Effect: Immediately
Related Feature: Reporting Events
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Specifies the ordered list of key names used for reporting the UC Connector Preview offer
parameters.

Important
The preview-info-keys values must correspond to the keys provided in the ICON
option AgentUserFields.

preview-itx-arrival-timeout

Default Value: 9000
Valid Values: Any positive integer
Changes Take Effect: Immediately
Specifies the length of time, in milliseconds, that the UC Connector will wait for the interaction to
arrive after the Preview Notification was accepted by the Knowledge Worker.

preview-expiration-timeout

Default Value: 15000
Valid Values: Any positive integer
Changes Take Effect: Immediately
Specifies the length of time, in milliseconds, that the UC Connector will wait for the Knowledge
Worker response (accept or reject) to the Preview Notification. A countdown timer in the preview
window shows how much time is remaining. If the timer runs out, the call is returned to the URS
routing strategy.

preview-state-name

Default Value: 3721,UCC_Preview
Valid Values: A string in the format <number>,<keyname>
Changes Take Effect: Immediately
Related Feature: Reporting Events
Specifies the numeric identifier and the key name of the custom state associated with the UC
Connector Preview offer.

Important
The preview-state-name values must correspond to the value of the ICON option
AgentRecordUserTypes.

preview-shortkey-accept

Default Value: Blank
Valid Values: A string in alpha-numeric or ASCII decimal number format
Changes Take Effect: After Restart
Specifies the hotkey used to accept a call when the Preview window is displayed. If left blank, the
shortcut key is disabled.For details on the ASCII and alpha-numeric formats, see Configuring Hotkeys
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for Interaction Preview.

Important
The Preview window must be in focus for the hotkey to function.

preview-shortkey-reject

Default Value: Blank
Valid Values: A string in alpha-numeric or ASCII decimal number format
Changes Take Effect: After Restart
The hotkey used to reject a call when the Preview window is displayed. If left blank, the shortcut key
is disabled. For details on the ASCII and alpha-numeric formats, see Configuring Hotkeys for
Interaction Preview.

Important
The Preview window must be in focus for the hotkey to function.

redirect-setup-enabled

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
This global option enables all users to set and enable a redirect number. This value can be
overwritten by the Person-level redirect-setup-enabled option.

sync-when-logout

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Controls whether UC Connector logs in a user when only the Lync presence is available (that is, there
is no independent login from a Genesys desktop client). In general, set this option to true in a back-
office environment with complete Smart Link functionality. Set it to false when integrating with Lync
Voice in the contact center.

• Also see Free Seating.

userdata-preview-format<n>

Default Value: title: <UserData_DisplayName>, value: [UserData_Key]
Valid Values: title: <UserData_DisplayName>, value: [UserData_Key]
Changes Take Effect: Immediately
Specifies which UserData key-value pair will be displayed in the Preview window, as well as how it will
be displayed. For example, to display the UserData kvp custname with the title Customer Name in the
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Interaction window, configure the option as follows:

• title: Customer Name, value: [custname]

• You can name the <n> variable in this option in numerical order (1, 2, 3) as you add more kvps, or you
can leave it empty.

user-unregister-timeout

Default Value: 60000 (1 minute)
Valid Values: Any positive integer
Changes Take Effect: Immediately
Specifies the length of time, in milliseconds, that UC Connector will wait after Knowledge Worker has
closed all browser sessions before it unregisters the Knowledge Worker DN with T-Server/SIP Server.

userdata-call-format<n>

Default Value: title: <UserData_DisplayName>, value: [UserData_Key]
Valid Values: title: <UserData_DisplayName>, value: [UserData_Key]
Changes Take Effect: Immediately
Specifies which UserData key-value pair will be displayed in the Interaction window, as well as how it
will be displayed. For example, to display the UserData kvp cust-account with the title Account in
the Interaction window, configure the option as follows:

• title: Account, value: [cust-account]

• You can name the <n> variable in this option in numerical order (1, 2, 3) as you add more kvps, or you
can leave it empty.

userdata-contact-format

Default Value: title: Contact, value: [USER-ID]
Valid Values: title: Contact, value: [USER-ID]
Changes Take Effect: Immediately
Specifies whether the Customer field will be displayed in the Interaction window

• If this option is enabled (with valid values), UC Connector checks the UserData attribute for the key
name customer. If found, UC Connector includes the value for this key in the Contact field of the
Preview Notification and Interaction windows.

• For example, if the key-value pair customer=Bank of Nova Scotia is found in the UserData, then UC
Connector will display Customer Bank of Nova Scotia in the Preview Notification and Interaction
windows.

userdata-note-key

Default Value: KW_ITX_NOTES
Valid Values: Any text
Changes Take Effect: Immediately
Specifies the key-name to be used for the notes taken by by the Knowledge Worker during the
interaction, and returned to the contact center as user data. By default, the key name for Know edge
Worker notes in the user data is KW_ITX_NOTES.
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userdata-onringing

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector will display UserData when the call to the Knowledge Worker is in the
ringing state.

userdata-note-onpreview

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector will display the UserData Notes (configured in userdata-note-key)
when the Preview Interaction is initially presented to the Knowledge Worker.

• Limitation: For agent notes that will appear in the Preview window, the text cannot contain a single (")
mark. URS does not process this quotation mark as regular text, but as a text delimiter. In other words,
any text after this quotation park will not be included in the Preview window.

userdata-note-onringing

Default Value: false
Valid Values: true, false</tt
Changes Take Effect: Immediately
Specifies whether UC Connector will display the UserData Notes (configured in
userdata-note-key) when the call to the Knowledge Worker is in the ringing state.

userdata-contact-onpreview

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector will display the contact information for the caller in the Preview
Notification sent to the Knowledge Worker.

userdata-contact-onringing

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector will display the contact information for the caller when the call to the
Knowledge Worker is in the ringing state.

userdata-title

Default Value: Case data
Valid Values: Any text
Changes Take Effect: Immediately
Specifies the title for the user data that is displayed in the Knowledge Worker Call Control or Preview
window. By default, this part of the client UI uses the title Case data. You can use any other name for
this section by changing the value of this option.
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userdata-note-title

Default Value: Notes
Valid Values: Any text
Changes Take Effect: Immediately
Specifies the title for the section of the UC client interface where the Knowledge Worker can input
notes about the interaction. By default, this area is named Notes. You can use any other name for
this section by changing the value of this option.

user-auto-registration

Default Value: false
Valid Values: true, false
Changes Take Effect: At application restart
Enables automated DN registration of all Knowledge Workers configured in the Genesys environment,
at the moment the UC Connector application starts. If set to true, UC Connector will begin monitoring
all user DNs and their presence on the UC platform automatically, without requiring individual
Knowledge Workers to log in to Genesys. For example, in integrations with Microsoft Lync Server, no
custom tab is available for Knowledge Worker log in; in this case, this option must be set to true.

• Also see Free Seating.

Important
The auto-registration will fail if the Knowledge Worker is currently on a call. If the
registration does fail, UC Connector will try again after the DN is no longer busy or (in
the case of some other login failure) when the Knowledge Worker's UC presence
changes.

Microsoft-OCS Section

Configure these options in the Microsoft-OCS section of the UCC Application object. This section
must be created using the correct syntax for the supported UC platform you are integrating with:
Microsoft-OCS.

agent-onnote-tstatus<x>

Default Value: No default value
Valid Values: <tserver status>, <note>
Changes Take Effect: Immediately
Only for Knowledge Workers using Smart Link, ignored for presence-only integration. Specifies the
text for the triggering note, as well as the corresponding Genesys status. If enabled, when the
Knowledge Worker enters a note that matches the text configured in this option, UC Connector will
change the status for this Knowledge Worker to the specified Genesys agent state. To configure this
option, enter the value <tserver status>, <note> in the following pattern:

<tserver status> Enter the Genesys status that the note will trigger.
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It can be any of the following Genesys states:
ready, not ready, logout.

<note> Enter the text for the triggering note.

• For example, if you configure agent-onnote-tstatus1 to the value NotReady, I am busy, when the
Knowledge Worker enters "I am busy" in the Lync / Skype for Business client, the Genesys agent state
is changed to NotReady.

Important
Use the variable <x> in the name of this option when creating multiple triggering
notes (set X to 1, 2, 3 and so on as you add more notes). If you have only one
triggering note, you can leave out this variable.

agent-status-ready

Default Value: 3500, 0-4499
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
Skype for Business Presence States
Changes Take Effect: Immediately
Used for both UC Connector integration with Lync or Skype for Business Enterprise Voice, and for
Enterprise Knowledge Workers. Specifies the presence status on the Microsoft side that will be
mapped to the Genesys status of Ready.

agent-status-notready

Default Value: 6500, 4500-17999
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
Skype for Business Presence States
Changes Take Effect: Immediately
Used for both UC Connector integration with Lync or Skype for Business Enterprise Voice, and for
Enterprise Knowledge Workers. Specifies the presence status on the Microsoft side that will be
mapped to the Genesys status of NotReady. You can map several status codes to the NotReady state,
by adding a comma-separate list of status codes. For example, 6500, 9500, 12500, 15500.

agent-status-logout

Default Value: 18500,18000-
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
Skype for Business Presence States
Changes Take Effect: Immediately
Used for both UC Connector integration with Lync or Skype for Business Enterprise Voice, and for
Enterprise Knowledge Workers. Specifies the presence statuses on the Microsoft side that will be
mapped to the Genesys status of Logout. Typically, you will map several Microsoft presence statuses
to match the Genesys Logout status.

contact

Default Value: No default value
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Valid Values: Valid SIP URI
Changes Take Effect: Immediately
Used for both UC Connector integration with Lync or Skype for Business Enterprise Voice, and for
Enterprise Knowledge Workers. Specifies the Knowledge Worker name for the UC Connector as
configured in Microsoft. This value matches the sign-in name for the Knowledge Worker in Microsoft
Lync / Skype for Business. For example, sip:sfb-ucc@your-sfb-address.com

enable-push-oncall-status

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Only for Knowledge Workers using Smart Link, ignored for presence-only integration. Enables the
overall Push On Call Status feature. If enabled, when the Knowledge Worker receives a call from the
Genesys environment, the Microsoft status is set on the Lync / Skype for Business side, according to
the value of the oncall-status option.

invite-message

Default Value: "Please use the window on the right to access data about current
interactions"
Valid Values: Any text string
Changes Take Effect: Immediately
Only for Knowledge Workers using Smart Link, ignored for presence-only integration. Specifies the
text that will be presented to the Knowledge Worker in the "conversation extension" window when an
interaction arrives. The window will only be enabled if this option is present and has a value
configured.

oncall-status

Default Value: 9500 (recommended 6500)
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
Skype for Business Presence States
Changes Take Effect: Immediately
Only for Knowledge Workers using Smart Link, ignored for presence-only integration. Specifies the
status to be updated in the Lync / Skype for Business client when a Knowledge Worker receives a call
from the Genesys environment.

Important
Genesys recommends that you change the value of this option from the default 9500
to the value 6500. The value 9500 corresponds to the status DoNotDisturb on the
Microsoft side, in which case interaction sessions cannot be established. Use the value
6500 (Busy) instead.

presence-acw-note

Default Value: Working after call
Valid Values: Any string
Changes Take Effect: Immediately
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Used for Lync / Skype for Business Enterprise Voice Integration only. Specifies the presence note that
UC Connector uses when an agent enters the After Call Work state. For Lync / Skype for Business
voice terminals, UC Connector uses this value for the presence update to Lync when the agent enters
the After Call Work phase. Note: Smart Link does not support After Call Work (ACW).

Important
The ampersand (&) and less than (<) symbols should not be used in the string value.
Microsoft Lync / Skype for Business does not accept presence updates if the
presence-acw-note option contains an ampersand (&) or less than (<) symbol. It
rejects the presence update from UC Connector and the user will not be set into the
state specified by the presence-acw-status option.

presence-acw-status

Default Value: 6500
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
Skype for Business Presence States
Changes Take Effect: Immediately
Used for Lync / Skype for Business Enterprise Voice Integration only. Specifies the presence state that
UC Connector uses when an agent enters the After Call Work state. UC Connector uses this value for
the presence update to Lync / Skype for Business when an agent enters the After Call Work phase.
Note: Smart Link does not support After Call Work (ACW).

presence-lg-note

Default Value: Statutory pause
Valid Values: Any string
Changes Take Effect: Immediately
Used for Lync / Skype for Business Enterprise Voice Integration only. Specifies the presence note that
UC Connector uses when an agent exits the After Call Work state and enters the Legal Guard state.
UC Connector uses this value for the presence update to Lync / Skype for Business when an agent
exits the After Call Work state and enters the Legal Guard state. Note: Smart Link does not support
After Call Work (ACW).

Important
The ampersand (&) and less than (<) symbols should not be used in the string value.
Microsoft Lync / Skype for Business does not accept presence updates if the value of
the presence-lg-note option contains an ampersand (&) or less than (<) symbol. It
rejects the presence update from UC Connector and the user will not be set into the
state specified by the presence-lg-status option.

presence-lg-status

Default Value: 6500
Valid Values: Any valid MS-PRES protocol interoperability code. See Interoperability Values for Lync
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Skype for Business Presence States
Changes Take Effect: Immediately
Used for Lync / Skype for Business Enterprise Voice Integration only. Specifies the presence state that
UC Connector uses when an agent exits the After Call Work state and enters the Legal Guard state.
UC Connector uses this value for the presence update to Lync / Skype for Business when an agent
exits the After Call Work state and enters the Legal Guard state. Note: Smart Link does not support
After Call Work (ACW).

presence-sync-mode

Default Value: pull
Valid Values: push, pull
Changes Take Effect: After restart
Introduced in UCC 8.0.3. Used for both UC Connector integration with Lync or Skype for Business
Enterprise Voice, and for Enterprise Knowledge Workers. Use this option for Presence Connector
Mode.

• If set to pull, UCC uses Presence Integration.
• If set to push, UCC uses Presence Connector Mode.

When UC Connector is working in "push" (Presence Connector) mode, synchronization of Microsoft
presence states (Presence Integration mode) is disabled. Instead, UC Connector pushes Microsoft
presence states to Lync / Skype for Business when the Genesys agent state changes. UC Connector
will push the Microsoft presence state to Lync / Skype for Business regardless of the current Lync /
Skype for Business user state, so will push even if the Lync / Skype for Business user is in a signed-
out state.

TLib Agent State Push
UC Connector pushes the Microsoft presence state to Lync / Skype for Business based on the
following TLib events and options:

TLib Event Option Default Value
EventAgentNotReady agent-status-notready 6500,4500-17999
EventAgentReady agent-status-ready 3500,0-4499
EventAgentLogout agent-status-logout 18500,18000-

• UC Connector uses first value from the range for making a presence update request. For example, UC
Connector will use 6500 for the EventAgentNotReady event.

• For disabling push, set the value of the corresponding option to -1. For example, agent-status-
logout=-1.

• UC Connector cannot sign-out or sign-in a Lync / Skype for Business user. Assuming that option agent-
status-logout has a value of 18000 or greater then UC Connector updates the Microsoft presence
state to "Offline", but the Lync / Skype for Business client will remain in a signed-in state.

On Call, After Call Work States Push
The option enable-push-oncall-status controls the push of the above states.
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Multiple DNs Push
If a Knowledge Worker is logged into multiple DNs, the Lync contact presence is pushed based on the
following table:

DN State Presence
All DNs in state Ready Available
One DN state is Not Ready Busy
One DN state is On Call Busy + note

registrar-uri

Default Value: No default value
Valid Values: Valid SIP URI
Changes Take Effect: Immediately
Used for both UCC configuration and Lync / Skype for Business Enterprise Voice integration. Specifies
the URI that UC Connector uses to connect with the Microsoft Front End Server. For example,

sip:pool01.server-address.com

subscribe-batch-size

Default Value: 5
Valid Values: Range from 1 to 100
Changes Take Effect: After restart
Starting with release 8.0.300.43, UC Connector can now subscribe agents in batches using the above
option. this option specifies the number of agents that are subscribed at one time.
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Other Options

License Section

license-file

Default Value: No default value
Valid Values: Any valid port address in the format,
<your_license_server_port>@<your_license_server_host> or the full path to the license file.
Changes Take Effect: After restart
Specifies the location of the license file.

num-of-seat-licenses

Default Value: max (all available licenses)
Valid Values: 0 or string max, or any integer from 0-9999.
Changes Take Effect: After restart
Specifies how many seat licenses UC Connector checks out. UC Connector treats a value of 0 (zero)
the same as it treats max—that is, it checks out all available licenses.

The sum of all num-of-seat-licenses values for all concurrently deployed UC Connector instances
must not exceed the number of seat-related licenses in the corresponding license file. The primary
and backup UC Connector share the same licenses, and therefore they need to be counted only once.
UC Connector checks out the number of licenses indicated by the value for this option, regardless of
the number actually in use.

Log Section

There is one UC Connector-specific option available for the Log section. For the common Log options,
see the Framework 8.1 Deployment Guide.

internal

Default Value: error
Valid Values: Error, Warn, Info, Debug
Changes Take Effect: Immediately
Specifies the log priority for internal UC Connector components.
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Switch/DN Level Options
Contact Point DNs
The options described in this section concern Routing Point DNs used to create contact points that
the Knowledge Worker uses to direct call transfers or conferences to the contact center. All options
must be configured in the UC-Connector section of the Annex tab.

attribute<n>

Default Value: No default value
Valid Values: format: <display text>: %s, statistic:<object>, <ObjectType>,
<TenantName>, <StatType>, <TimeProfile>, <StatServerName>
Changes Take Effect: Immediately
Specifies the statistic to be displayed when the Knowledge Worker hovers their cursor over the
contact point in their Interaction window. You can name the <n> variable in this option in numerical
order (1, 2, 3) as you add more statistics, or you can leave it empty.

If this option contains both the format and statistic fields, UC Connector subscribes to retrieve the
specified statistic from Stat Server. All statistic types supported by Stat Server are available.

The valid format for this option value is as follows:

• format—Set this option to the text you want to be displayed in the Interaction window. Include the %s,
for the statistic to be displayed.

• statistic—Set this option to the parameters required by Stat Server to properly fetch the relevant data:
Object, ObjectType, TenantName, StatType, TimeProfile, StatServerName.

Important
The parameter StatServerName is only required if UC Connector connects to more
than one Stat Server.

• An example of a valid configured value is as follows:

format: Calls waiting: %s, statistic:1234@YourSwitch, RoutePoint, YourTenantName,
CurrNumberWaitingCalls, Default, StatServer1

For details about statistic types, see the Stat Server 8.5 User's Guide.

display-name

Default Value: No default value
Valid Values: Any valid string
Changes Take Effect: After application restart
Specifies the name to be displayed for the configured contact point (typically a Routing Point DN or
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ACD Queue) in the Knowledge Worker's Interaction window.

enabled

Default Value: true
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether this Routing Point DN is enabled for use with UC Connector. Set this option to
true to enable the contact point.

presence-gateway-mode

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether UC Connector prevents sending invite messages to Lync when there is no web
client UI connected for the corresponding user, and a new call or preview call is delivered. If true, UC
Connector does not send SIP INVITE to Lync; otherwise, sending the invite is controlled by the invite-
message option.

Knowledge Worker Person Object

For Knowledge Worker Person objects, the following options are available.

UC-Connector Section

enabled

Default Value: true
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether this Person object is enabled for use with UC Connector. Set this option to true to
enable this Knowledge Worker Person object.

redirect-setup-enabled

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Enables a user to set and enable a redirect number. This values takes priority over the global
redirect-setup-enabled option.

redirect-enabled

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Specifies whether the configured redirect number can be used to accept previews. If true, UC
Connector uses the configured redirect number to accept previews. This option can only be
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configured for a Person.

redirect-number

Default Value: blank
Valid Values: A string representing a valid phone number
Changes Take Effect: Immediately
Specifies the redirect number available to the Knowledge Worker. This option can only be configured
for a Person.

Microsoft-OCS Section

agent-status-ready

Default Value: No default value
Valid Values: Interoperability Values for Lync Skype for Business Presence States
Changes Take Effect: Immediately
Specifies the presence status for this Knowledge Worker on the Lync / Skype for Business-side, which
will then be mapped to the Genesys status of Ready. Typically, you will map several Lync / Skype for
Business presence status to match the Genesys NotReady status. For example, 3500, 3000-4499.

agent-status-notready

Default Value: No default value
Valid Values: Any valid MS-PRES protocol interoperability
Changes Take Effect: Immediately
Specifies the presence status for this Knowledge Worker on the Lync / Skype for Business-side, which
will then be mapped to the Genesys status of NotReady. Typically, you will map several Lync / Skype
for Business presence status to match the Genesys NotReady status. For example,
6500,9500,12500,15500,4500-17999.

agent-status-logout

Default Value: No default value
Valid Values: Interoperability Values for Lync Skype for Business Presence States
Changes Take Effect: Immediately
Specifies the presence statuses for this Knowledge Worker on the Lync / Skype for Business-side,
which will then be mapped to the Genesys status of Logout. Typically, you will map several Lync /
Skype for Business presence statuses to match the Genesys Logout status. For example,
18500,0-2999,18000-.

contact

Default Value: No default value
Valid Values: Valid SIP URI
Changes Take Effect: Immediately
Specifies the principal for the Knowledge Worker as configured in Lync / Skype for Business. This
value matches the sign-in name for the Knowledge Worker in Lync / Skype for Business. For example,

sip:ucc_user1@your-LSfB-address.com
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enable-push-oncall-status

Default Value: false
Valid Values: true, false
Changes Take Effect: Immediately
Enables the overall Push On Call Status feature. If enabled, when the Knowledge Worker receives a
call from the Genesys environment, the status is set on the Lync / Skype for Business-side, according
to the value of the oncall-status option.

oncall-status

Default Value: 9500 (recommended 6500)
Valid Values: Interoperability Values for Lync Skype for Business Presence States
Changes Take Effect: Immediately
Specifies the status to be updated in the Lync / Skype for Business client when a Knowledge Worker
receives a call from the Genesys environment.

Important
Genesys recommends that you change the value of this option from the default 9500
to the value 6500. The value 9500 corresponds to the Lync / Skype for Business status
DoNotDisturb on the Microsoft side, in which case interaction sessions cannot be
established. Use the value 6500 (Busy) instead.
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Log Events
This section describes the UCC log events, including log events that are generated by UC Connector
in a warm standby high-availability (HA) configuration.

Log Events for HA Warm Standby

00-04560
Level: Standard
Text: Warm Standby (backup) mode activated
Attributes: None
Description: Management Layer command: reports that the backup server is working in Warm
Standby mode.

00-04562
Level: Standard
Text: Warm Standby (Primary) mode activated
Attributes: None
Description: Management Layer command: reports that the primary server is working in Warm
Standby mode.

When you configure your UC Connector HA deployment, you will create Alarm Conditions (two on the
primary UC Connector and two on the backup UC Connector) for warm standby HA log events. You
will configure the Alarm Conditions to trigger Alarm Reaction scripts, which will in turn run application
objects for scripts that execute the SIP Server switchover.

SIP Stack Log Messages

UC Connector can detect if the SIP Stack is not running, and generate the appropriate Genesys log
messages:

• 31401—SIP Layer Creation Failure

• 31402—SIP Layer Created (To cancel the alarm)

To activate the alarm functionality, perform the following steps:

1. On the Options tab in the log section of the UC Connector Application, add the following key-value pairs:
• MessageFile=<path to the UCC.lms file>
• standard=network

2. Add the connection to the Message Server. Open the connection of a Solution Control Server and make
sure that you are using the same Message Server.
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3. Create a new Alarm Condition configuration object with the following properties:
• On the Detect Event tab, enter the following:

• Log Event ID: = 31401

• Selection Mode: = Select by Application

• Application = The appropriate UC Connector application name.

• On the Cancel Event tab, enter Log Event ID: = 31402
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T-Server Compatibility with UC Connector
This section lists T-Server support for the emulated agent functionality in UC Connector.

T-Server Version UC Connect Compatibility
Alcatel A4200 7.6 No
Alcatel A4400/OXE 8.0+ Yes
Aspect ACD 8.0 No
Avaya Communication Manager 8.0+ Yes
Avaya INDeX 8.0+ Yes
Avaya TSAPI 8.0+ Yes
Cisco UCCE 8.0+ Yes
Cisco UCM 8.0+ Yes
Digitro AXS/20 7.5 No
EADS Intercom M6880 8.0 No
Ericsson MD110 8.0+ Yes
Huawei NGN 7.6 No
Mitel SX-2000/MN-3300 7.2 No
NEC NEAX/APEX 8.0 No
Nortel CS1000 8.0+ Yes
Nortel CS2000 8.0+ Yes
Rockwell Spectrum 8.0 No
Siemens Hicom 300/HiPath 4000
CSTA I 7.6+ Yes

Siemens HiPath 4000 CSTA III 8.0+ Yes
Siemens HiPath DX 8.0+ Yes
Tadiran Coral 8.0+ Yes
Genesys SIP Server 8.0+ Yes
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